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Chapter 1

What is LapLink Professional?

LapLink Professional gives you complete access to another computer from any loca-
tion. Whether you're using a modem, network, wireless device, or cable, you can con-
nect to other computers that are also running LapLink. Once you are connected, you can
transfer files between the computers. When you’re at home or on the road, you can use
files and programs on your office computer—as well as other computers on your office
network. You can even “chat” (through Text Chat) with someone sitting at your office
computer while you work with office files from a remote location.

Go to illustration >

Connect as you want

Using a modem, network, wireless device, or cable, you can use LapLink
to connect to other computers. In one session, you can connect to several
computers, using a variety of connection methods. You are limited mainly
by the number of devices and resources on the computers.

You can also take advantage of the Dial-Up Networking feature of Win-
dows to connect by modem to other network computers running LapLink.
Using this modem-to-network connection provides full access to the net-
work; it’s like being connected to the network directly.

Different situations call for different connection methods. Cables and wire-
less devices work well when connecting your laptop to your desktop com-
puter from a short distance. Networks make it easier to connect to many
different computers in your local company network, a wide-area network,
or the Internet. Modems work well at any time when you can use a phone
line to connect—whether you're at home or on the road or communicating
with someone in another company.

Use the services you want

LapLink services—File Transfer, Remote Control, Print Redirection, and Text
Chat—offer four ways to communicate with other computers. You can
select one or more services as you connect and add other services as you
need them. In the same session, you can use different services simulta-
neously or at different times, on one computer or several.

O With File Transfer, you can move or copy files between computers. Cus-
tomizing any of the several File Transfer options simplifies complicated
transfers. And using Xchange Agent automates the repetitive process of
keeping two computers in sync.

Traveling Software’s patented SpeedSync technology makes updating
files faster by comparing files so that only changes—not entire files—are
transferred. A comprehensive security system, including encryption,
protects your valuable data at all times.

O With Remote Control, you use your computer to control another com-
puter. It's as though your keyboard, mouse, and screen were connected
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Everything you need for
easy, reliable access
to your office PC.
Guaranteed.

to the other computer. It does not matter whether a computer is con-

trolling or being controlled; the setup and startup procedures are iden-
tical.

O With Print Redirection, you can work on a document at one end of a
LapLink connection and print it at the other end. For example, you can
use Remote Control to prepare a document on the office computer and
print it on your home printer for proofing.

£ You can set up Print Redirection any time after setup by starting
LapLink and clicking Print Redirection on the Options menu.

O With Text Chat, you “talk” with someone at another computer by
exchanging typed messages. When you have only one phone line, you
can use your modem to connect to the remote computer for File Trans-
fer or Remote Control, and then use Text Chat to talk to the person at
the other end.

< Go to topic summary
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What you can do in LapLink Professional

LapLink gives you four services for working with other computers: File Transfer,
Remote Control, Print Redirection, and Text Chat. Other features like Xchange Agent and
Address Book save time and simplify your work.

Go to illustration >

v You can copy in-
formation on one
computer and paste
it on another com-
puter.

v To protect the
confidentiality of
files you send over
the Internet, you
can have LapLink
encrypt them be-
forehand.

Choosing the right service for the job you need to do is simple when you're
using LapLink. You have four services to choose from: File Transfer,
Remote Control, Print Redirection, and Text Chat. Being familiar with their
distinctions makes choosing the right service easier.

LaplLink is versatile, designed specifically so you can use services when
you want, as you want. Use one service at a time or all services at once.
Use one service when connecting to the first remote computer; use a dif-
ferent service when connecting to another computer.

Work on a remote computer

Using the Remote Control service, you can operate a remote computer
using your computer’s keyboard and mouse. You can use the remote com-
puter’s programs, files, and network connections.

Since all the work you do is actually performed on the remote computer,

Remote Control is especially helpful to laptop owners who can’t use their

office computer’s programs on their laptop. Remote Control is also helpful
when you're telecommuting or troubleshooting a remote computer.

Transfer files between computers

Whether you're hundreds of miles away or in the same room, use the File
Transfer service to exchange files between computers.

Use Xchange Agent to automate the process of keeping files on two com-
puters synchronized. You can even set up Xchange Agent to run automati-
cally, when you are away from your computer.

Print over a LapLink connection

Using the Print Redirection service, you can prepare a document at home,
make a LapLink connection to your office computer, and then print the
document on an office printer. Or you can reverse the process and print an
office document at home.

Send and receive messages

Use the Text Chat service to hold a conversation with someone at another
computer by exchanging written messages. You can use your modem to
connect to the remote computer for File Transfer, for example, and then
use Text Chat to coordinate with the person at the other end.
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Choose the LapLink services for the needs at hand

Use File Transfer for a fast and efficient way of exchanging files.

Use Xchange Agent to automate file synchronizations.

Use Remote Control to run programs and access files on a remote

Use Print Redirection to work on a document at one end of a

Use Text Chat to communicate with remote users, consult with

Connect to a network

Over a modem, you can connect to a network from home or on the road
and use the same network resources you enjoy in the office. You can com-
bine this “remote-node” connectivity with LapLink services, such as File
Transfer and Remote Control.

As a remote node, for example, you can direct a document you‘ve pre-
pared away from the office to a network printer, read and answer your
e-mail, and browse the network. In the same session, you can use LapLink
to run a database program on your office computer and work on large,
shared files on the network—or connect to another network computer and
review a presentation in preparation on that computer.

Connect over the Internet

Connect to another computer over the Internet from anywhere in the
world. You can use any LapLink services for the cost of a connection to a
local Internet service provider.

Save time

Simplify connections by storing telephone numbers, passwords, and other
information in Address Book entries. Then select an Address Book entry,
and the connection will be opened for you.

Use SpeedSync to save time when you’re updating files. Instead of send-
ing entire files, SpeedSync sends only the parts that have changed since
the last update. Overall times for transferring files can be cut drastically.

< Go to topic summary

v’ Use encryption to
protect information
you transfer over
the Internet.

v Set up the secu-
rity system to de-
fine who has access
to your computer
and what services
they can use.
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Getting help

When you need help getting your work done, use the LapLink online Help system. For
instructions on working in a dialog box, simply open the dialog box. A Quick Steps win-
dow appears automatically. (To disable Quick Steps, click to release the Quick Steps but-
ton on the LinkBar.) For detailed instructions on identifying and solving problems you
may encounter, consult a troubleshooter: click Help Topics on the Help menu and open
the Troubleshooting book. Through Help, you can also get explanations of items in a dia-

log box and buttons on a toolbar.

Go to illustration >

v To get Help for a
command without
opening its dialog
box, open the
menu, point to the
command, and
press F1.

v Even after dis-
abling Quick Steps,
you can get Help for
a particular dialog
box by clicking the
Help button in the
dialog box.

Refer to Quick Steps for step-by-step instructions

When you click a button to make a connection or choose a command from
one of the menus, a Help window appears beside the dialog box. Refer to
the window for a concise, step-by-step guide though the dialog box.

You can also use Quick Steps to:

O Find related topics, including one with detailed information about all the
items in the current dialog box.

O View tips for finishing the task.

O Display the complete list of topics in the LapLink Help system. (Click
Help Topics.)

You can prevent Quick Steps windows from appearing by disabling the fea-
ture.

To disable Quick Steps:
B On the LinkBar, click to release the Quick Steps button.
To enable Quick Steps again, click to press the Quick Steps button.

Use Troubleshooting topics when you get stuck

Answers to questions most commonly asked by users appear in the Trou-
bleshooting topics. In many cases, a Troubleshooting topic takes you
directly to the dialog box where you can find the solution to your problem.

To use Troubleshooting:

1 On the Help menu, click Help Topics. (If you have a Help window open,
click the Help Topics button in the window instead.)

2 Click the Contents tab.
3 Click the Troubleshooting book, and then click Open.
4 Click a topic under Troubleshooting, and then click Display.
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Getting help in a dialog box

When in doubt about With Quick Steps enabled, a
something in a dialog box, window appears automati-
click the question mark cally beside a dialog box to
button. Then click the help you complete the task.
item.
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Related Topics

Tip=s

To use a modem not listed, click Port Setup to install it. Hew Bookmark

Go to Bookmark

' o =" To disable Quick Steps, click to
B8 ‘ % | i % @ | '?_:@— release the Quick Steps But-

ton on the LinkBar.

£ In the Help Topics window, you can also browse through topics listed < Go to topic summary
alphabetically (click the Index tab) and find topics containing a certain
word or phrase (click the Find tab).

Determine what’s what on the screen

When you’re not sure about something on the screen, you can display a
brief explanation of what it is or does.

To find out about an item on the screen:

B In a dialog box, click the question mark button, and then click the item. v Click anywhere to
Or use the right mouse button to click the item, and then click the What's ~ make a pop-up ex-
This? command. planation disappear.

B On a toolbar, place the mouse pointer over a button for a second or two.
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Connecting to other computers—Overview

Using LapLink, you can connect to one or more computers using a variety of connec-
tion methods. All computers must be running LapLink before they can connect. After
you've connected, you can use any combination of the LapLink services such as File
Transfer and Remote Control. You can open services while you connect to another com-
puter or after you've connected.

Go to illustration >

v To connect two
computers, LapLink
must be running on
both.

v Connections by
wireless and by par-
allel and USB cable
are not available in
Windows NT.

v Cable and wire-
less connections are
not protected ini-
tially by security;
you can secure
these in the Secu-
rity dialog box. See
online help for infor-
mation.

v If security is not
an issue, you can
open your computer
to any LapLink
user: click the Se-
curity button on the
LinkBar and then
click Anybody (Pub-
lic System). Use this
option with caution!

When you connect to another computer, you'’re making an outgoing con-
nection. To complete the connection, the other computer accepts your
incoming connection. The computer you are working at is the local
computer. The computer accepting your connection is the remote com-
puter.

Before you can connect two computers, both must be running LapLink.
You can then connect by modem, network, cable, wireless, or CAPI 2.0/
ISDN. Which type of connection you choose depends on where the remote
computer is.

If the two computers are close together, you might use cable or wireless.
If you're in the same company, you might use a network. If you're in sep-
arate locations, not connected by network, modems work best.

Changing security to allow incoming connections

You must change security settings to allow incoming connections by net-
work, modem, or CAPI 2.0/ISDN. Initially, LapLink allows you to make
outgoing calls, but nobody can connect to your computer by those meth-
ods. Likewise, you can connect only with those remote computers that
allow incoming connections.

To set up password-protected access to your computer:
1 Click the Security button on the LinkBar.
2 On the General tab, click Log-in List Only.

3 On the Log-in List tab, add an entry for each user you will allow to
access your computer.

4 In each entry specify the log-in name and the password necessary for
access. Also grant the user permission to use some or all of the services
as well as the locking and callback features.

For more information about creating an entry in your Log-in List, see
page 48.

Making outgoing connections

When you make an outgoing connection, you follow the same basic steps
regardless of how you're connecting or the services you intend to use.
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Changing security settings and opening connections
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To make an outgoing connection: < Go to topic summary

1 Click the Connect button on the LinkBar; then click the type of connec-
tion you're using.

2 Click the name of the computer you want to connect to, or type the
remote computer’s phone number if connecting by modem.

3 Check the service, or combination of services, you want to use.
4 Click OK or Dial.

Disconnecting

When you disconnect, you end communication with the remote computer.
You can disconnect your connections individually, or all at the same time.

To disconnect from the remote computer:

1 Click the Disconnect button on the LinkBar.

2 In the Connection list, click the name of the remote computer.
3 Click OK.
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Connecting by modem—Overview

With LapLink Professional, you have a choice of connections over a modem: a direct
connection between two computers running LapLink or a LapLink connection combined
with the Dial-Up Networking feature of Windows.

Go to illustration >

v A server can be a
specialized server
available from many
manufacturers. Or it
can be your Win-
dows computer run-
ning dial-up server
software.

Direct LapLink-to-LapLink connections

A LapLink-to-LapLink connection requires only that both computers run
LapLink and be connected by modem. When you dial directly in to another
LapLink computer, you have access to all the programs and files available
to that computer, including any network resources. You can:

O Transfer files between the computers. Using LapLink’s compression and
patented SpeedSync technology, you can transfer data faster than is
possible with Dial-Up Networking.

O Control the remote computer to run its programs and access its files.
Through Remote Control, you can efficiently run large programs on the
remote computer and access large files (including multiuser files such
as order-entry systems or accounting systems).

If the remote computer is attached to a network, you can use its copy of
LapLink to exchange files indirectly with other network computers running
LapLink.

Using Dial-Up Networking without LapLink

When away from the office, you can connect to your office computer and
network using a modem to dial in to a remote access server on the net-
work. You can then work as if you were connected directly to the network,
though the slow connection speed may limit your activities.

With proper configuration at both ends of the connection, Dial-Up Net-
working lets you:

O Make small file transfers using Windows Explorer.

O Run programs on your local computer and edit smaller files on the net-
work.

O Send documents on your local computer to network-based printers.

O Read and send e-mail messages.

Combining LapLink with Dial-Up Networking

Using LapLink with Dial-Up Networking, you enjoy all the advantages of
both kinds of connections, with these additional benefits:

O You can establish a connection to another LapLink computer on the net-
work, and open services such as File Transfer and Remote Control.
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Access only the net-
work files available
to the computer you
dial in to.

File
server

LapLink to LapLink

.., - -

Exchange files indirectly

Dial in to another computer running LapLink to with other network com-
run programs on that computer and access its puters. (Direct File Trans-
files. = fer and Remote Control

P=ioi s are not available.)

LapLink with Dial-Up Networking

Remote
access
server

Dial in to a remote access server for access to a
network. Then connect directly to other network
computers running LapLink to run programs on
those computers and access their files.

Network log-in protec-
tion adds another
level of security.

O Security is enhanced by combining LapLink password protection with < Go to topic summary
network security. When you dial in to a server, you must provide a net-
work log-in name and password. When you connect to another LapLink
computer, you must also provide the log-in name and password
required by that computer.
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Connecting by modem
Making a LapLink-to-LapLink connection by modem

lf you're connecting to another computer using a modem, you must first attach the
modem correctly to your computer and phone line. To connect to the other computer,
start LapLink, click the Connect button on the LinkBar, and click Modem. Then choose
among the modem connections you have entered in Address Book.

Go to illustration >

¥ Dialing Proper-
ties replaces the
Suffixes and Pre-
fixes feature of ear-
lier versions of
LapLink.

v To review or
change any of the
settings for your di-
aling location, click
Dial Properties.
When you travel,
it's important to
keep your dialing lo-
cation up to date.

You can make a LapLink-to-LapLink connection to any other computer in
the world when both computers have modems and are attached to phone
lines. Using the manufacturer’s guidelines, connect the modem to a serial
(COM) port on your computer and to a phone line.

To connect two computers by modem, both must be running LapLink, and
their modem ports must be enabled.

Dialing from an Address Book entry

Before dialing a computer, it's a good idea to create an entry for that connec-
tion in Address Book. Address Book entries store phone numbers, requests
for services (such as File Transfer and Remote Control), passwords, and other
information pertinent to each connection. When you dial a connection, this
information is passed on to the remote computer for you.

Though you do not dial from Address Book, you can choose among its entries
when you connect to a remote computer. For information about using
Address Book for modem connections, see page 24.

When you dial a connection you have entered in Address Book, you use
the Dialing Properties feature of Windows. Through the settings you spec-
ify in Dialing Properties, you determine how your calls are dialed in
LapLink. Use these settings to charge a call to a calling card, update your
location while traveling, reach an outside line, and place long-distance and
international calls.

To connect to another computer by modem:
1 Click the Connect button on the LinkBar, and then click Modem.
2 In the Connection list, click the connection you want to open.

The connections listed under Manual Dial are your Address Book entries
for modem connections. To create a new entry, click Address Book.

3 In the Dialing Location list, click the location you're dialing from.

4 Under Services, check the services you want, such as File Transfer and
Remote Control.

5 Click Dial.
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Dialing manually

To dial a connection that is not complicated by such considerations as call-
ing cards, outside lines, and country codes, you can type the phone num-
ber without creating an Address Book entry beforehand. LapLink dials the
number exactly as you type it, regardless of how you have set up Dialing
Properties.

To dial manually:

1 Click the Connect button on the LinkBar, and then click Modem.
2 Click Manual Dial.

3 In Phone Number, type the number to dial.

4 Click Dial.

< Go to topic summary

v To allow incom-
ing modem connec-
tions, you must
change your com-
puter’s security
setup. See page 48.
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Connecting by modem
Connecting to a network by modem: Dial-Up Networking

Connecting to a network using Dial-Up Networking provides the most versatile kind of
modem connection. You can access network resources as a “remote node” and then
open LapLink connections with any other network computers running LapLink. The com-
puters at both ends of this connection must be configured for remote access.

Go to illustration >

¥ For help in config-
uring computers for
Dial-Up Network-
ing, consult Help in
Windows.

v You can make a
LapLink connection
anytime during a
Dial-Up Networking
session by clicking
the Connect button
on the LinkBar and
then clicking Net-
work.

LapLink lets you dial in to a remote access server on your office network.
You can then access network resources and open LapLink connections to
other computers on the network as you would from your office computer.

To make a LapLink connection to another computer over Dial-Up Network-
ing, both computers must be running LapLink. In addition:

O The local computer (the one you dial from) must be configured with the
Dial-Up Networking feature of Windows.

O The remote computer (the one you dial in to) may be a dedicated
server (such as Novell NetWare Connect, Windows Remote Access
Server, or Shiva NetModem) or a computer running dial-up server soft-
ware.

To connect to a network by modem:

1 Click the Connect button on the LinkBar, and then click Dial-Up Net-
working.

2 In the Dial-Up Networking Connection list, click the server you want to
connect to.

3 In the Dialing From list, click the location you're dialing from.

To review or change any of the settings for your dialing location, click
Dial Properties.

4 If you do not want to open a LapLink connection as soon as the Dial-Up
Networking connection is established, clear this box: After Connecting
to the Network, Choose a LapLink Connection.

5 Click Dial.

% For the list of Dial-Up Networking connections, LapLink shows the dial-
up servers set up in Windows on your computer. To learn more about a
server or to change the phone number or select a different modem,
click Properties. To set up a new connection, click New Connection and
follow the instructions on your screen.

E When you make a Dial-Up Networking connection in LapLink, you use
the Dialing Properties feature of Windows. Through the settings you
specify in Dialing Properties, you determine how your calls are dialed.
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Use these settings to charge a call to a calling card, update your loca-

tion while traveling, reach an outside line, and place long-distance and

international calls. Dialing Properties replaces the Suffixes and Prefixes
feature of earlier LapLink versions.

< Go to topic summary
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Connecting by modem
Using Address Book for modem connections

Making entries in Address Book simplifies the process of making modem connections
and opening service windows. Use Address Book entries to store phone numbers,
requests for services (such as File Transfer and Remote Control), and passwords. When
you dial a connection, this information is passed on to the remote computer for you. In
addition, Address Book entries work in combination with Dialing Properties, the Windows
feature you can use for dialing outside lines, using calling cards, and placing long-dis-
tance and international calls.

Go to illustration >

v The information
you store in Address
Book will be sent
automatically to a
remote computer
when you dial. You
do not open a con-
nection from Ad-
dress Book itself.

v To change an Ad-
dress Book entry,
click the entry, and
then click Edit. To
copy an entry for
revision as a new
entry, click Copy.

v Your requests for
services in Address
Book will be hon-
ored only if the se-
curity setup of the
remote computer
permits.

Address Book is a convenient way of storing all the information you need
to make a modem connection. Enter the information once, and it will be
there whenever you need it again. Your Address Book entries will be avail-
able when you connect using Connect over Modem.

By creating Address Book entries, you can also take advantage of Dialing
Properties, the Windows feature that lets you determine how your num-
bers will be dialed. Set up your Dialing Properties to charge a call to a call-
ing card, update your location while traveling, reach an outside line, and
place long-distance and international calls. For more information about
Dialing Properties, see the Windows documentation.

To create an entry in Address Book for a modem connection:
1 Click the Address Book button on the LinkBar.

If you have set up password protection for your security system, you
are now asked to type the password.

2 Click Add.

3 In Description, type a brief description of the remote computer for your
own reference.

4 In Computer Name, type the exact name assigned to the remote com-
puter in LapLink.

5 In the Connection Type list, click Modem.

6 Under Phone Number, type the area code and phone number, and iden-
tify the location of the remote computer.

7 Under Services, check the services you want to use when you connect
to the remote computer, such as File Transfer and Remote Control.

You will be able to change your selections later, as part of the connection
process. You will also be able to request new services after you connect.
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Creating a modem entry in Address Book
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8 Under Host Locking on Connect, check the kind of locking, if any, you < Go to topic summary
want to take effect on the remote computer when you connect for
Remote Control.

You can lock a host (blank its screen or disable its mouse or keyboard)
only if it has been configured to allow locking.

9 Under Security Information to Send, type the log-in name and the pass-
word you must provide in order to gain access to the remote computer.
Reenter the password to confirm.

When you have finished the entry, you see Address Book and the v Case is irrelevant
description of the new entry. If you want to create another entry, click in LapLink pass-
Add again and complete the entry. Otherwise, click Close. words: a capital Dis

_ treated the same as
-]l If you want to have a phone number dialed exactly as you type itin an  alowercase d, for
Address Book entry, clear this box: Use Country Code and Area Code. example.
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Connecting over the Internet

The Internet is a worldwide collection of networks running the TCP/IP protocol. Since
LapLink Professional supports TCP/IP networks, you can connect any two computers that
have dialed in to the Internet. That means you can use the LapLink services (such as File
Transfer and Remote Control) anywhere in the world, all for the cost of a connection to a
local Internet service provider (ISP).

Go to illustration >

v To prepare a
computer to re-
ceive incoming In-
ternet connections
by modem, start
LapLink and dial in
to your Internet
service provider us-
ing Dial-Up Net-
working.

Requirements for using LapLink over the Internet

Before you connect over the Internet, configure both Windows and
LapLink:

O In Windows, install the Microsoft TCP/IP protocol stack. Do not install
any other TCP/IP stack.

O In LaplLink, enable the TCP/IP port in Port Setup.

Making a LapLink connection over the Internet

How you make a LapLink connection over the Internet depends on how
you access the Internet. There are two common ways of accessing the
Internet:

O Over a modem connection to an Internet service provider.
O Over a direct connection from a corporate network.
To open a LapLink connection by modem over the Internet:

1 In Laplink, dial in to your Internet service provider: click the Connect
button on the LinkBar, and then click Dial-Up Networking.

The Connect over Network dialog box appears when you connect.

2 On the TCP/IP Addresses tab of the Connect over Network dialog box,
type the remote computer’s Internet (IP) name or address in the
TCP/IP Name or Address box. (For information about Internet names
and addresses, see the next section.)

3 Specify the services you want to open at the start of the connection,
such as File Transfer and Remote Control.

4 Click OK.

To open a LapLink connection over the Internet from a corporate
network:

1 Start LapLink.
2 On the LinkBar, click the Connect button. Then click Network.
3 Click the TCP/IP Addresses tab.
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4 Type the remote computer’s Internet (IP) name or address in the
TCP/IP Name or Address box.

For information about Internet names and addresses, see the next sec-
tion.

5 Specify the services you want to open at the start of the connection,
such as File Transfer and Remote Control.

6 Click OK.

5 To simplify repeat connections to a computer with a permanent Internet
address, create an entry in Address Book. Identify the connection type
as TCP/IP.

3 To use your network for LapLink connections over the Internet, the net-
work must have Internet access, your computer must be configured
with Microsoft TCP/IP software, and the network’s security system must
allow LapLink connections. Consult your system administrator if in
doubt.

< Go to topic summary

v To prepare a
computer to re-
ceive incoming In-
ternet connections
over a corporate
network, enable the
TCP/IP portin
LapLink Port Setup.
Then leave LapLink
running.
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Connecting over the Internet
Determining an Internet address

To connect to another computer over the Internet, you must know the computer’s
Internet name or address. Conversely, anyone wanting to connect to your computer,
must know its Internet name or address. A computer’s address on the Internet can vary
from session to session, or it can remain constant, depending on how the Internet is
accessed. With access to the proper software, however, names can be used instead of
addresses; names do not change from session to session and thus simplify the process

of connecting.

Go to illustration >

v Internet ad-
dresses consist of a
series of numbers,
with periods as
separators:

for example,
255.255.255.255.

When you connect to another computer on your local area network (LAN),
you choose from a list of connections available to you. When you connect
over the Internet, however, you must provide the computer’s Internet (IP)
address or name; there is no list of computers to choose from.

Connecting to a computer with a temporary Internet address

If you connect to an Internet service provider by modem, it’s likely that
your Internet address is assigned dynamically; that is, the address is dif-
ferent every time you connect. (Consult your Internet service provider if in
doubt.)

To open a connection to a computer having a temporary address, you
have this choice:

O Use “name-resolution” software to maintain a permanent Internet
name even though your address changes every time you connect to the
Internet. For information about the free WINS service offered by Travel-
ing Software, see page 30.

O Without name-resolution software, someone must determine the
remote computer’s temporary address after connecting to the Internet
and e-mail you the information. You then type the address in the Con-
nect over Network dialog box. (If someone wants to connect to your
computer, you must determine your own address and e-mail the other

party.)

Connecting to a computer with a permanent Internet address

If you connect to the Internet directly from your corporate network, your
Internet address is probably permanent. Some Internet service providers
also offer permanent addresses; even if you dial in to such providers, your
address is the same from session to session.

Connecting to a computer with a permanent address simplifies the con-
nection process, since you always know what to type as the address in the
Connect over Network dialog box.
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Determining your Internet address in Windows 95 or Windows 98
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& Some networks include a name-resolution service called DNS (Domain < Go to topic summary
Name System), which converts permanent addresses to hames. A
DNS name looks like an e-mail address (for example,
janed.acme.com), but never includes @. If your network uses DNS,
other users can connect to your computer using the DNS name.
Determining an Internet address
To determine your Internet address in Windows 95 or Windows 98:
1 Do either of these:

¢ If you access the Internet by modem through an Internet service
provider, start LapLink and connect using Dial-Up Networking. (See
the previous section for details.)

¢ If you access the Internet directly from your corporate network, start
LapLink.

2 Click Port Setup on the Options menu.

3 Click TCP/IP Network in the Ports list, and then click Configure.
4 Your Internet address appears in the IP Address box.

To determine your Internet address in Windows NT:

1 If you access the Internet by modem through an Internet service pro-
vider, start LapLink and connect using Dial-Up Networking. (See the
previous section for details.)

2 Click the Windows Start button, point to Programs, and click Command
Prompt.

3 Type IPCONFIG and press ENTER.
The TCP/IP address for that computer appears in the IP Address line.
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Connecting over the Internet

Using the Traveling Software WINS server for Internet
connections

A WINS server allows computers with temporary (“dynamic”) Internet addresses to
connect using permanent names. Even though your address is different every time you
connect to the Internet, other computers will be able to locate your computer by specify-
ing your WINS name. As a free service to its users, Traveling Software, Inc., offers a

WINS server to facilitate LapLink connections over the Internet.

Go to illustration >

v To connect to a
computer using its
WINS name, type
the name in the IP
Name or Address
box in the Connect
over Network dia-
log box.

v To connect over
the Internet using
WINS names, two
computers must be
configured for the
same WINS server
and the same scope
ID.

Most users who dial in to an Internet service provider are assigned tempo-
rary addresses. With only temporary addresses to go by, LapLink users
must rely on e-mail to pass on their current addresses once they have
connected to the Internet.

Users who want to open LapLink connections over the Internet can over-
come the issue of temporary addresses by using a WINS (Windows Inter-
net Naming Service) server. A WINS server matches a Windows computer
name to the computer’s current Internet address. Once users have config-
ured their computers for the same WINS server, they can locate each
other using their WINS names (that is, their Windows computer names).

Traveling Software offers a WINS server as a free service to LapLink users.

% If you are already using a WINS server, you do not have to switch to the
one offered by Traveling Software. If you do switch, however, be sure to
record the address of the original server; other programs may rely on
that server.

To configure your computer for the Traveling Software WINS
server:

1 In Windows, click the Start button and then point to Settings.
2 Click Control Panel and then double-click Network.

3 On the Identification tab, make note of your computer name. This is
your WINS name (other users will use this to connect to your com-
puter).

If necessary, edit the name to avoid duplicating the name of any com-
puter you plan to connect to.

4 In Windows 95 or Windows 98, click the Configuration tab, click
TCP/IP —> Dial-Up Adapter, and then click Properties. Then, click the
WINS Configuration tab. On that tab, click Enable WINS Resolution.

In Windows NT, click the Protocols tab, click TCP/IP Protocol, and then
click Properties. Click the WINS Address tab.
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Setting up the Traveling Software WINS server in Windows 95 or 98
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5 In the Primary WINS Server box, type this address: 198.102.198.10 < Go to topic summary

6 In the Scope ID box, type an identifier to be used by you and the other
LapLink users you want to connect to.

Begin a scope ID with a letter and follow it with any combination of let-
ters and numbers (avoiding signs and symbols). Uppercase and lower-
case letters are treated the same way.

7 Click OK and restart Windows.

8 Ask other LapLink users to configure their computers for the Traveling
Software WINS server. Inform them of your WINS name (step 3) and
your scope ID (step 6).

-Tl By using a scope ID, you speed up service and minimize the possibility
of duplicating the name of another computer (duplicate names are
allowed in different scope IDs but not in the same one). You also restrict
your access to other computers configured with the same scope ID. (If
you omit a scope ID, the other users should do the same.)
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Connecting over the Internet
Internet security and firewalls

LapLink connections over the Internet may require special configuration if either of the
computers has a direct connection to the Internet over a corporate network. Before con-
necting over the Internet, LapLink users should ensure that their data is being encrypted
before being transferred.

v If you have any
questions about
your corporate net-
work, consult the
network administra-
tor.

Firewalls and LapLink

To protect their data from unauthorized access, corporations commonly
insulate their corporate networks from the Internet with firewalls, which
selectively allow data to pass between the two.

Without the proper configuration, LapLink connections over the Internet
will probably be prevented if either of the computers is on a private or cor-
porate TCP/IP network.

LapLink requires the use of two TCP/IP ports: one for the host (the com-
puter receiving the incoming connection) and another for the guest (the
computer opening the connection).

To facilitate LapLink connections over the Internet, Traveling Software,
Inc., has registered port 1547 with the Internet Assigned Numbers
Authority. This port is used by the host computer.

To allow LapLink connections through a firewall, a network administrator
should open port 1547.

With most networks, this is the only configuration required. With other
networks, however, it may be necessary to specify a port for use by the
guest computer.

In many cases, the TCP/IP stack assigns guest computers the next avail-
able TCP port number above port 1024, and the firewall automatically
allows the connection.

If the firewall does not allow automatic port assignment, however, LapLink
must be configured on the guest computer to request a specific port. Con-
sult your network administrator before making this change.

To request a specific port on a guest computer, add the following section to
the computer’s LLW.INI file (the file is located in the \TSI32\LLW folder
within the Windows folder):

[TCPIP]
ClientPort=xxxxx
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For xxxxx type any number between 1025 and 65535, except 1547. Using
a large number—for example, one above 30000—reduces the chance of
conflicts with another TCP/IP application.

Securing your data on the Internet

The Internet is a large, unregulated network. When transferring data,
keep in mind that the data can be intercepted. To keep any intercepted
data from being interpreted, set LapLink to encrypt the data beforehand.

To encrypt all data exchanged in a LapLink connection:

1

2

On the Options menu, click Security. Or click the Security button on the
LinkBar.

On the Encryption tab, check this box: Encrypt All Information
Exchanged with a Remote Computer.

Click OK.

Be sure to enable encryption before you open a connection to another
computer. Changing the setting during a connection won't have any
effect until you connect again.
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Connecting by network

lf you're connecting to another computer over an IPX (Novell) or a TCP/IP network,
make sure that the other computer’s security settings have been changed to allow you to
connect. To connect to another computer, click the Connect button on the LinkBar; then

click Network.

Go to illustration >

v To connect two
computers over a
network, both must
be running LapLink,
and their network
ports must be en-
abled.

v If your network
port is not yet en-
abled, the Port
Setup dialog box
appears when you
connect.

Networks offer users (and the companies that maintain them) features for
sharing files, exchanging files, sharing peripherals, and exchanging elec-
tronic mail between computers. A network can link two computers across
a room or thousands of computers and a wide variety of peripherals in
several buildings.

If you're using a network, you can use LapLink to connect to other com-
puters on your network. In the same LapLink session, you can also con-
nect to other computers using a cable or modems.

Connecting to another computer by network

Before you can connect to another computer on the network, security set-
tings on that computer must be changed. If you are going to accept
incoming LapLink connections, your computer’s security settings must be
changed. For more information, see page 48.

To connect to another computer by network:
1 Click the Connect button on the LinkBar, and then click Network.

2 In the Available Now list, click the name of the computer you want to
connect to.

If the computer is not listed and you are attempting to connect over a
TCP/IP network, you can access it though its IP name or address. See
the next section for more information.

3 Under Services, check the services you want to use, such as File Trans-
fer and Remote Control.

4 Click OK.

Filtering the list of available network computers

You can display the name of a particular computer in the Connect over
Network dialog box by typing all or part of the name in the Computer
Name Filter box; then click Refresh List.

Specifying the name of a particular computer can speed up the process of
opening a LapLink connection when you are connecting to a network by
modem, using Dial-Up Networking.
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next to the Computer Name Filter box, click All Computers, and then click
Refresh List.

&} After connecting to a network using Dial-Up Networking, use the Con-
nect over Network command to connect to other network computers.

5 The LapLink name assigned to each computer on a network should be
unique. To avoid conflicts, you may use your network log-in name.

Ji» Use Address Book in LapLink to make connecting easier. If you regularly
connect to the same computers, add those computer names to Address
Book. For more information, see page 38.
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Connecting by network
Connecting to computers outside of your TCP/IP

subnetwork

Only computers on your local TCP/IP subnetwork appear as available connections
when you attempt to connect by network. To connect to a computer beyond your sub-
network, click the TCP/IP Addresses tab in the Connect over Network dialog box and type
the computer’s IP name or address.

Go to illustration >

v For information
on making a
LapLink connection
over the Internet,
see page 26.

v You can use an IP
name only if there is
a server available to
resolve (translate)
the name into its
real IP address.

TCP/IP is the protocol used to connect over many corporate networks as
well as the Internet. Each computer on a TCP/IP network has a unique
address. You don't need to know this address to connect to other comput-
ers on your subnetwork; the names of these computers appear in the list
of available connections when you connect.

You can connect to a computer outside of your subnetwork by specifying
its IP address or name. An IP address consists of numbers (such as
255.255.255.255). A name consists of a string of characters (such as jan-
edoe.acme.com). It is often similar to an e-mail address but never
includes the @ symbol.

To connect to a computer outside of your TCP/IP subnetwork:
1 Click the Connect button on the LinkBar, and then click Network.

2 Click the TCP/IP Addresses tab.

3 Under TCP/IP Name or Address, type the nhame or address.

4

Under Services, check the services you want, such as File Transfer and
Remote Control.

5 Click OK.

% Use Address Book to make connecting easier. If you regularly connect
to the same computers over TCP/IP, add their IP names or addresses to
Address Book; you can then click a connection instead of typing its
name or address. For more information, see the next section.

Finding a TCP/IP address

To find out your TCP/IP address in Windows 95 or Windows 98:
1 Click Port Setup on the Options menu.

2 Click TCP/IP Network in the Ports list, and then click Configure.

3 Your Internet address appears in the IP Address box.
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To find out your Internet address in Windows NT: < Go to topic summary

1 Click the Windows Start button, point to Programs, and click Command
Prompt.

2 Type IPCONFIG and press ENTER.
The TCP/IP address for that computer appears in the IP Address line.
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Connecting by network
Using Address Book for network connections

Simplify the process of opening connections and services by making Address Book
entries for network computers you frequently connect to. For each Address Book entry,
you specify the type of network (Novell IPX or TCP/IP), the kinds of services (such as File
Transfer and Remote Control) to be opened automatically, and any security information
required by the remote computer. For TCP/IP connections, you can also store the IP
address. The information you save in Address Book is used when you open a connection
using the Connect over Network command.

Go to illustration >  Address Book stores information and requests that will be sent automati-
cally to a remote computer when you open a connection over a network.
You do not open a connection from Address Book itself.

v You can use Ad- To create an entry in Address Book for a network connection:
dress Book for mo- . )
dem, cable, and 1 Click the Address Book button on the LinkBar.

other kinds of con- If h t d tection f it t t
nections in addition you have set up password protection for your security system, type

to network connec- the password.
tions. 2 Click Add.

3 In Description, type a brief description of the remote computer for your
own reference.

4 In Computer Name, type the exact name assigned to the remote com-
puter.

Type the computer name assigned in LapLink, not the IP hame.
5 In the Connection Type list, click Network IPX or Network TCP/IP.

6 If you selected Network TCP/IP, type the IP name or address of the
remote computer under TCP/IP Address.

v Your requests for 7 Under Services, check the services you want to open when you connect

services in Address to the remote computer, such as File Transfer and Remote Control.
Book will be hon-

ored only if the se- 8 Under Host Locking on Connect, check the kind of locking, if any, you
curity setup of the want to take effect on the remote computer when you connect for
remote computer Remote Control.

permits.

You can lock a host (that is, blank its screen or disable its mouse or key-
board) only if it has been configured to allow locking.

9 Under Security Information to Send, type the log-in name and the pass-
word you must provide in order to gain access to the remote computer.
Reenter the password to confirm.
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Creating a network entry in Address Book

Type a description for your
own reference.

Type the exact name Diescription: k. i Haonolulu oK

assigned in LapLink to the 0 Mame:_[Harkcs Laptop —

remote computer.

Type a Description ahd choogze a Connection Type.
Right-click ather fields for mare infarmatian,

Connection Tppe, s ==yt

Help

E Connect over - %‘5 | ‘ On the LinkBar, click the Address Book button.

Add Address Book Entry \

dls

Click a type of network EEIP Addre
connection Type the remote computer's TCPAP name or address.
! For example: J anel og ACME . Com or 123.233.7100.30.

For a TCP/IP

[1232331003 connection,
S type the IP
I File Transfer IV Bemate Contral [ Print Redirection name or ”
Check the services you [ Test Chat address of the

want to use.

Type the log-in name and

Host Locking on Connect
’7|_ Screen Blank, V¥ Mouse Disable W Kepboard Disable

password required by the

- Security Information to Send
Log-in M ame: IHankLuau

remote computer.

Paszword: I

remote com-
puter.

When you have finished the entry, you see Address Book and the
description of the new entry. If you want to create another entry, click
Add again and complete the entry. Otherwise, click Close.

% The log-in name and password you type in Address Book must match a
log-in name and password entered in the security system on the
remote computer. (Case is irrelevant in LapLink passwords: a capital D
is treated the same as a lowercase d, for example.)

% To edit an entry in Address Book, click the entry, and then click Edit. To
copy an entry for revision as a new entry, click Copy. To delete an entry,
click Delete.

< Go to topic summary
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Connecting by cable

lf you're connecting to another computer using a cable, you must first decide which kind
of cable you’'ll use—serial, parallel, or USB—and plug the cable into both computers.
Start LapLink on both computers. Autoconnect, the default setting for cable connections,
connects the computers automatically when you start LapLink. To manually connect,
click the Connect button on the LinkBar, and then click Cable.

Go to illustration >

v Parallel and USB
cable connections
are not available in
Windows NT.

v To connect two
computers over a
cable, both must be
running LaplLink,
and the appropriate
ports must be en-
abled on both.

You must choose the type of cable—serial, parallel, or USB (Universal
Serial Bus)—you are going to use based on the cables and ports you have
available.

Ports are the connectors to which you attach cables and peripherals like
printers and external modems. To find out which types of ports are avail-
able, consult the documentation or the Windows Device Manager for your
computer.

Once you decide which kind of cable connection you’ll use, plug a LapLink
cable into both computers: Attach a LapLink serial cable to a serial port on
each computer, a LapLink parallel cable to a parallel port on each com-
puter, or a LapLink USB cable to a USB port or a USB “hub” device on each
computer.

Cables you can use for LapLink connections
For a serial, parallel, or USB connection use a LapLink cable.

If there is more than one type of port available to you, remember that par-
allel cables transfer data faster than serial cables. And USB cables, the
fastest of the three, transfer up to seven times faster than serial cables.

In addition, you can attach a USB cable to any USB peripheral that incor-
porates a “hub” to which other devices can be connected. This feature lets
you use more than one USB-compatible device at a time.

Connecting to another computer by cable

When you start LapLink on two computers connected by cable, they will
automatically connect. Autoconnect, the default setting for cable connec-
tions, causes the computers to connect automatically. If you change this
setting, you can connect to the other computer manually.

{l If the connection does not open automatically, click Port Setup on the
Options menu and verify that the appropriate port (COM, LPT, or USB)
is enabled for cable.

To manually connect to another computer by cable:
1 Click the Connect button on the LinkBar, and then click Cable.
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Connecting by cable manually
Click the Connect button on the LinkBar,

= ] .
‘E Connectover = a3 ‘ and then click Cable.
' hodem _
@} DiaHJp Netwarking
@_’I" Metwork Connect over Cable EE

Choose a computer that is connected to yours by
cable, LapLink must be running on bath PCs.

Click OK

— Connection
ok_—}— when you
e AN are ready to
_ Gl || open the
connection.
Address Book... |
Port Setup... |

Click the name
of the computer
to connect to.

Chooze OK to open one of mare windows

far the selected computer. Help |

 Services
Check the ser- I Eile Trarster [~ Bemote Contral [ Print Redirection
vices you want ™ Test Chat
to use.
< Go to topic summary
2 In the Connection list, click the name of the computer you want to con- v If your cable port
nect to. is not yet enabled,
the Port Setup dia-
3 Under Services, check the services you want to use, such as File Trans- log box appears
fer and Remote Control. when you try to
connect.

4 Click OK.

£ To turn Autoconnect off, click Connect Options on the Options menu. On
the Connect tab, clear the Enable Autoconnect box.
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Connecting by wireless

lf you’'re connecting to another computer using wireless, simply start LapLink, and the
connection is opened for you. Autoconnect, the default setting for wireless connections,
lets computers connect automatically when you run LapLink. To connect manually, click
the Connect button on the LinkBar, and then click Wireless.

Go to illustration >

v Wireless connec-
tions are not avail-
able in Windows NT.

v To connect two
computers by wire-
less, both must be
running LaplLink,
and the appropriate
wireless port must
be enabled on both.

Connecting to another computer by wireless

When you start LapLink on both computers, they will automatically con-
nect by wireless. Autoconnect, the default setting for wireless connections,
forces the computers to connect automatically. If you change this setting,
you can connect to the other computer manually.

If the connection does not open automatically, click Port Setup on the
Options menu and verify that the appropriate COM port is enabled for
wireless.

{l In LapLink wireless connections are short-range, usually between two
infrared devices. If you are using a cellular modem, connect using Con-
nect over Modem. If you are using a wireless LAN adapter, connect
using Connect over Network.

To manually connect to another computer by wireless:
1 Click the Connect button on the LinkBar and then click Wireless.

If your wireless port is not yet enabled, the Port Setup dialog box
appears when you click Connect and then Wireless.

2 In the Connection list, click the name of the computer you want to con-
nect to.

3 Under Services, check the services you want to use, such as File Trans-
fer, and Remote Control.

4 Click OK.

£ To turn Autoconnect off, click Connect Options on the Options menu. On
the Connect tab, clear the Enable Autoconnect box.

Using infrared devices

In LapLink you can connect over infrared devices set up in Windows 95 or
Windows 98. The Windows infrared driver supports a variety of built-in
ports, including fast infrared devices, as well as adapters connected to
serial ports. If the driver is not installed on your computer, you can down-
load it from the Microsoft site on the Internet.

% When you install the infrared driver, specify any one of the COM ports
from COM1 to COM9 as the redirected port. In LapLink, click Port Setup
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Connecting by wireless manually
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(Options menu) and enable the same redirected port for wireless com- < Go to topic summary
munications.

Using AirShare Radio Modules

You can connect over AirShare Radio Modules by editing the LapLink ini-
tialization file, LLW.INI. (The file is located in the \TSI32\LLW folder within
your Windows folder.)

Open LLW.INI in Notepad and locate the section corresponding to your
wireless port: [COM1], [COM2], and so on. Edit the section so that it
includes this line: UselRDADriver=No. Restart LapLink; in Port Setup
(Options menu), ensure that the port is enabled for wireless communica-
tions.
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Connecting over CAPI 2.0/ISDN

When connecting to another computer over CAPI 2.0/ISDN, ensure that the other computer
is also equipped with CAPI 2.0/ISDN and its security settings have been changed to allow let you
connect. To connect, click the Connect button on the LinkBar; then click CAPI 2.0/ISDN.

Go to illustration >

v CAPI 2.0/ISDN is
not available in
LapLink unless CAPI
2.0/ISDN is in-
stalled on your
computer.

v Before you can
connect to another
computer over
CAPI 2.0/ISDN, se-
curity settings on
that computer must
be changed. See
page 48.

v Be sure to include
any required coun-
try or area codes.
These aren’t added
automatically to the
number.

CAPI 2.0/ISDN is an implementation of ISDN that provides two channels
for the transfer of voice and data. In LapLink these channels can be used
separately, for two concurrent connections, or combined for a single, high-
speed connection.

CAPI 2.0/ISDN is widely used in Europe, particularly in Germany. In North
America ISDN seldom is implemented as CAPI 2.0, but you can still use
your ISDN device for high-speed LapLink connections: If you use your ISDN
device as a modem, use Connect over Modem in LapLink. If you use it to
dial in to, and log on to, a network, use Connect over Network in LapLink.

Requirements for using LapLink over CAPI 2.0/ISDN

O A CAPI 2.0/ISDN adapter and driver must be installed on both comput-
ers.

O Both computers must be running a version of LapLink that supports
CAPI 2.0/ISDN.

Connecting to another computer over CAPI 2.0/ISDN
To connect to a computer over CAPI 2.0/ISDN:
1 Click the Connect button on the LinkBar, and then click CAPI 2.0/ISDN.

2 Click the name of the computer you want to connect to in the Connec-
tion list or type a phone number under Dialing.

The connections listed under Manual Dial are your Address Book entries
for CAPI connections. To create a new entry, click Address Book.

3 Under Services, check the services you want, such as File Transfer and
Remote Control. You can choose any combination of these services.

4 Click Dial.

Dialing from an Address Book entry

Before dialing a computer, it's a good idea to create an entry for that connec-
tion in Address Book. Though you do not dial directly from Address Book, you
can choose among its entries when you connect to a remote computer.

To create an entry in Address Book for a CAPI 2.0/ISDN connection:
1 Click the Address Book button on the LinkBar.
2 Click Add.
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Connecting over CAPI 2.0/ISDN
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3 In Description, type a brief description of the remote computer for your < Go to topic summary
own reference.

4 In Computer Name, type the exact name assigned to the remote com-
puter in LapLink.

5 In the Connection Type list, click CAPI 2.0/ISDN. v Requests for ser-
vices in Address
6 Under Phone Number, type the phone number. Book will be hon-

. . ored only if the se-
7 Under Services, check the services you want to use when you connect curity setup

to the remote computer (such as File Transfer and Remote Control). permits.

8 Under Security Information to Send, type the log-in name and the pass- ¢ LapLink pass-
word you must provide in order to gain access to the remote computer. WOrdS_are not case
Reenter the password to confirm. sensitive.
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Connecting over CAPI 2.0/ISDN
Changing CAPI performance in LapLink Professional

Before using CAPI in LapLink, you may want to customize the way that LapLink
responds to CAPI calls and uses the two channels available for LapLink communications.
For example, you can specify that LapLink not respond to any incoming calls to a partic-
ular channel, or you can double the rate at which data is transmitted over your CAPI con-

nections.

Go to illustration >

To change CAPI performance in LapLink:

1

2
3
4

7

Click Port Setup on the Options menu.
Under Port Settings, click CAPL.
Click the Configure button.

If you do not want LapLink to answer any incoming CAPI calls, clear the
Enable box under Auto Answer.

To answer calls to only one number, type the number in this box: Accept
Calls Only on the Following Numbers.

If you want to combine the two CAPI channels for faster connections,
check the Enable box under Channel Bonding.

Be sure that channel bonding is also enabled on the computer you will
connect to.

Customize the Timeout options as necessary.

The Callback Timeout, Callback Delay, and Redial Delay settings are in
seconds.

Click OK.

Answering calls

At the outset, LapLink is set up to answer all incoming CAPI calls on both
channels. You can modify this so that it does not answer any of these calls
or it answers calls to just one of the channels.

% If you don’t want LapLink to answer any incoming calls, clear the Enable

box under Auto Answer; then make sure that the Accept Calls Only on
the Following Numbers box is blank.

% When typing the number to accept calls to, use only numerals; avoid

characters like dashes, parentheses, slants, and periods. When typing
more than one number, use a semicolon to separate them.
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Changing CAPI 2.0/ISDN performance
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Channel bonding < Go to topic summary

CAPI provides two channels that can be used for LapLink communications.
Each channel has a transmission speed of 64 Kbps. By combining (“*bond-
ing”) these channels, the transmission rate can double, to 128 Kbps.

At the outset, LapLink does not use channel bonding, even when both
channels are available. This setting keeps transmission costs to a mini-
mum for users who pay additional fees for each channel connection.

For faster transmissions, enable channel bonding. When both channels are
available, LapLink can then transmit at speeds of up to 128 Kbps.

E Be sure to enable channel bonding on both computers. LapLink may not
be able to make a connection between them otherwise.

§ When one channel is already in use, LapLink uses the available channel
to transmit at 64 Kbps, even when channel bonding is enabled.
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Changing the security setup

After you install LapLink, you can make outgoing connections to other computers, but
other computers cannot open incoming connections to yours except by cable or wireless.
To allow incoming connections, change the security setup and create one or more entries
in the Log-in List. In each entry, specify the password and the log-in hame the user must
provide to gain access to your computer. Then grant privileges to use services and other
features. Any LapLink user who can provide the password and log-in nhame can connect
to your computer and operate within the restrictions you impose.

Go to illustration >

v If security is not
an issue, you can
open your computer
to any LapLink
user: click the Se-
curity button on the
LinkBar and then
click Anybody (Pub-
lic System). Use this
option with caution!

v Log-in names
and passwords can
contain 1-20 char-
acters, including let-
ters, numbers, and
spaces. Passwords
are not case-sensi-
tive: capitals and
lowercase letters
are treated the
same way.

The safest way to allow incoming connections is to set up password-pro-
tected access through the Log-in List. The number of entries you make in
your Log-in List will be determined by the number of special cases you
have in mind. If you want to allow one user to use only File Transfer, for
example, and another to use only Remote Control, create two entries, with
different log-in names and passwords.

On the other hand, a single entry would be enough if you will be the only
one to connect to the computer. A single entry will also suffice if you want
to grant several users the same privileges.

To set up password-protected access to your computer:
1 Click the Security button on the LinkBar.

2 On the General tab, click Log-in List Only (Protected System).
3 Click the Log-in List tab, and then click Add.
4

Under Guest Information, type the log-in name and the password the
user must provide in order to make a connection to your computer.

Reenter the password and click OK to confirm.

5 Under Services, check the services you want to make available to the
user, such as File Transfer and Remote Control.

(<))

Under Locking Permissions, click options to determine whether the user
can blank the screen of your computer and disable its mouse and key-
board. You can grant locking permissions only if you select Remote Con-
trol as one of the available services.

7 Under Modem Callback, click an option to determine whether, or how, a
user connecting by modem will be called back when opening a connec-
tion. If you click an option requiring a callback to a certain nhumber, type
the number in Phone Number. For details see the next page.

8 Click OK.

Setting callback options for incoming modem connections
None Prevents callbacks.
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Creating an entry in the Log-in List
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called back; users who choose to be called back can specify the number
to dial. This is the most flexible of all the options.

Optional, Specified Number Only Lets the remote user decide whether ¢ You can use call-
to be called back to the number you specify or to open the connection backs to save
without any callback. Only the number you specify in Phone Number can money, as when

be dialed for the callback. you call from a hotel
room. Requiring a

Required, Any Number Requires remote users to be called back but callback to a partic-
allows them to specify the number to be dialed. The number can vary from :Irfgggirt?gr?arla;gszl

session to session. of security.

Required, Specified Number Only Requires the remote user to be
called back to the number you specify in Phone Number. Click this option if
you always want the remote user to be called back to the same number.
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Changing the security setup
Securing your computer and encrypting the data you

transfer

Protecting your computer with a Local Security password prevents unauthorized users
from compromising your security system; it also keeps them from viewing your Address
Book entries and using them to open connections. Protecting your security system is a
particularly good idea if you allow others to control your computer remotely. Another
security measure, data encryption, is recommended if you connect to other computers
over the Internet or WANs (wide-area networks).

Go to illustration >

v Setting up pass-
word protection for
your security sys-
tem is important if
your computer
serves as a host to
other users in Re-
mote Control ses-
sions. Without
password protec-
tion, a remote user
could read your se-
curity information.

¢ In LapLink, pass-
words are not case-
sensitive: capitals
and lowercase let-
ters are treated the
same way.

Securing your computer

Setting a Local Security password ensures that the protections you set up
for your computer cannot be compromised—either by someone using your
computer in your absence or by remote users.

Without knowledge of your password, users cannot view or change any of
this information:

O Log-in names, passwords, and other Security settings

O Telephone numbers, passwords, and other information stored in your
Address Book entries

O Privileges you have granted to guest computers and other settings in
Remote Control Options

In addition, the same password is required for access to Connect over
Modem and certain Logging features.

To set a Local Security password:
1 Click the Security button on the LinkBar.

2 On the Local Security tab, check this box: Protect Local Security with a
Password.

3 In the Change Password dialog box, type the password in the New Pass-
word box. In the Confirm New Password box, type it again.

4 Click OK.

E To remove password protection, clear this box: Protect Local Security
with a Password. To change the password currently in effect, click the
Set Password button.

% By default, security is not imposed on incoming connections by cable
and wireless. If you set up password protection for modem and network
connections, however, you can extend that protection to cable and wire-
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Setting a password for your security system
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Enforce Security for Connections.

Encrypting information

LapLink always encrypts (encodes) log-in names and passwords. Unless
you specify otherwise, nothing else is encrypted. Encryption is usually not
necessary over LAN connections or other secure connections.

On the Internet or a WAN, however, security is an issue; the information
you exchange with another computer can be intercepted. Before connect-
ing over the Internet or a WAN, enable the encryption feature in LapLink.

To encrypt all information exchanged during a LapLink connection: ¢ Encryption is de-
termined entirely by

1 Click the Security button on the LinkBar. the setting on the
2 On the Encryption tab, check this box: Encrypt All Information ?t%%sgﬁgngggﬁ?;g
Exchanged with a Remote Computer. the connection); the

. setting on the host
3 Click OK. computer has no ef-

Be sure to enable encryption before you open a connection to another fect.
computer. Changing the setting during a connection won’t have any
effect until you connect again.
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Connecting automatically

Once you have established a connection, you can save it for easy restoration later. You
can restore a saved connection by double-clicking a shortcut icon, setting LapLink to
restore the connection automatically at startup, or restoring the connection while run-
ning LapLink. When LapLink restores a connection, it connects to the same computer or
computers and opens the same services.

Go to illustration >

v To connect auto-
matically to several
computers at once,
open connections to
those computers
before saving con-
nections. All con-
nections that are
open when you
save will be re-
stored automati-
cally.

v To completely au-
tomate the connec-
tion process, create
entries in Address
Book for saved con-
nections. Include
the log-in name and
password required
to open each con-
nection.

Instead of spending time connecting to the same computer and opening
the same service windows time after time, you can save the connection
and use the saved connection as a convenient way to reconnect later.

When you save a connection, you record such details as the number and
types of connections (modem, network, Internet, cable), the names of
computers, and the kinds of services in use. Each connection is saved as a
file. Opening the file reopens the connections and services and arranges
windows to appear much as they did before.

Saving a connection
To save a connection:

1 Open one or more connections as usual.

2 On the Connect menu, click Save Connections.

3 In the File Name box, type a name to identify the connection file.
a4

If you want to create a shortcut icon for restoring the connection, check
this box: Create a Shortcut to This File on the Desktop.

5 Click Save.

Restoring a saved connection
Once you have saved a connection, you can restore it three ways:

O Double-click the shortcut icon you created when you saved the connec-
tion. (The icon appears on the desktop, the large area you see when
you start Windows.)

O Set up LapLink to restore the connection when you run LapLink again.
O Open the connection file while running LapLink.

To set up LapLink to restore a saved connection when you start the
program:

1 On the Options menu, click Connect Options.
2 On the Startup tab, check this box: Restore Saved Connections at Startup.

3 Click the name of the connection file you want to open, or type it in the
Connection File box.
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Three ways to restore a saved connection
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If the file does not appear in the list of files, click the Browse button < Go to topic summary

and locate the drive and folder containing the file.

E Connection files have the .LLC extension. In Windows 95 and Windows
98, they are stored in the My Documents folder. In Windows NT, they
are stored in the \Profiles\yourname\Personal folder within the Win-
dows folder (where yourname is your Windows NT logon name).

4 If you want the connection restored without confirmation, click Auto-
matically Connect at Startup. Otherwise, click Ask Before Connecting.

5 Click OK.
To open a saved connection while running LapLink:
1 On the Connect menu, click Restore Connections.

2 Click the name of the connection file you want to open, or type it in the
File Name box.

If the file does not appear in the list of files, locate the appropriate drive
in the Look In box; then double-click the folder containing the file.

3 Click Open.
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Using Remote Control—Overview

When you open a Remote Control window on your computer, the computer in front of
you becomes the guest, and the remote computer displayed on your screen becomes the
host. From the guest, you can view and operate the host as if you were sitting in front of
it. Images from the host appear on your screen in a Remote Control window within the

LapLink workplace.

Go to illustration >

v You cannot open
a connection to a
remote computer
by modem or net-
work unless the de-
fault security setup
on that computer
has been changed
to grant you ac-
cess. For more in-
formation, see page
70.

¢ No one else can
control your com-
puter while you are
using Remote Con-
trol. Nor can a com-
puter be controlled
by anyone else
while you are con-
trolling it.

Remote Control provides a way to operate another computer at a distance.
You begin Remote Control as soon as you open a Remote Control window.
While you are working in this window, your mouse moves the mouse
pointer on the remote computer, your keyboard types characters on the
remote computer, and your Remote Control window shows the remote
computer’s screen.

Remote Control terminology
A LapLink Remote Control session creates two kinds of computers:

Guest The Remote Control window and the mouse and keyboard on the
guest are your links to the remote computer. Working in the Remote Con-
trol window, you use your mouse and keyboard to operate the host. Your
work, meanwhile, is being processed on the host computer.

Host There is no special procedure associated with setting up a host. The
computer need only be running LapLink and configured to allow incoming
connections. You do not need to be at the computer. On the other hand,
you may want to join the guest as an observer or an active participant.

Opening a Remote Control window

On a guest, you can open a Remote Control window at the time you con-
nect to the host. Or you can or open a Remote Control window sometime
after the connection is made. Because LapLink supports multiple connec-
tions, you can maintain several Remote Control windows, one for each
host computer.

To open a Remote Control window while connecting:

B Click the Connect button on the LinkBar and then click Modem, Network,
or some other means of connecting. Under Services, click Remote Con-
trol. (For complete information about connecting to other computers, see
chapter 2.)

To open a Remote Control window after opening a connection:

B Click the Open Remote Control button on the LinkBar. Or click Open
Remote Control on the Window menu.

; If you have more than one connection, select a window for the desired
connection before clicking the Open Remote Control button.
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Operating the host computer from the guest computer

What you see < Go to topic summary

The host screen appears on your screen as a window within LapLink. The
name of the host computer appears in the window’s title bar. You can
move, resize, minimize, or maximize the window as you would any other
window. Use the scrollbars to view other parts of the host screen.

If you prefer to display the host screen across your entire screen instead
of a window, press CTRL+SHIFT+F. Press CTRL+SHIFT+F again to return
to the window view. For more information about changing your view of the
host, see the next section.

% A host screen can be made to display full screen by default. To make
this change, click Remote Control Options on the Options menu. On the
Guest tab, check the Always Use Full-Screen box. The Remote Control
window then alternates between full screen and icon; the window view
is no longer available.

E There are several ways to customize Remote Control performance—
whether you want to enhance your view of the host or speed up perfor-
mance. For instance, you can use solid rather than dithered colors or
prevent the display of large bitmaps. For more information see page 70.
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Viewing the host

As a guest, you can alternate between two views of the host screen. Your first view
appears in a window within LapLink. Inside the window, you control the host; outside the
window, you perform other tasks, in LapLink or in other applications on your computer.
Switch to a full-screen view when you want to maximize your view of the host and use
Remote Control exclusively. When you cannot see the entire host screen even in full
screen, you can change the resolution of the host screen or scale its image to fit within

your view.

Go to illustration >

v You can substi-
tute another key
combination for
CTRL+SHIFT+F. For
more information,
see the next sec-
tion.

Devoting your entire screen to a view of the host
You can view the host screen in two ways:
O In a window within LapLink (the default)

O As a full-screen display, hiding LapLink and the rest of your Windows
workspace

In a window view, you have quick access to File Transfer, Text Chat, and
other LapLink features. You can also switch to other applications on your
computer.

To maximize the area in which you view and control the host, switch to a
full-screen view. Your entire screen is now devoted to controlling the host;
you do not have access to your own applications. When you want to do
something other than control the host, switch back to the window view.

To switch between window and full-screen view:
M Press CTRL+SHIFT+F.

% In full screen, you can also switch to a window from the copy of LapLink
running on the host: If LapLink is an icon, click it to restore it to a win-
dow. Then click the icon representing your Remote Control window, and
click Guest Full Screen to clear the check mark.

E To make Remote Control alternate between full screen and icon, bypass-
ing the window view, click Remote Control Options on the Options menu.
On the Guest tab, check the Always Use Full-Screen box.

Viewing the entire host screen at once

There are two ways to fit the host screen into your view:

O From your computer, lower the resolution of a higher-resolution host
screen to match that of your screen.

O Scale the image of the host screen to fit within your view.

Temporarily changing the resolution of the host screen When
using a laptop to control a desktop, you often can’t view the entire host
screen at once if the desktop operates at a higher screen resolution. From
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Alternating between a window and a full-screen view of the host

- -+ -
| | [ =0 | CTRL+SHIFT+F | | =i
By default, your view of the host When you switch to full-screen view,
screen appears in a window within the host screen occupies your entire
LapLink. screen, hiding your local Windows

workspace.

your laptop, you can lower the desktop’s screen resolution to match your < Go to topic summary
laptop’s.

You can then view all of the host screen in full-screen view. The original ¥ You cannot lower

resolution is restored automatically on disconnect or at your direction. the resolution of a
host computer un-

To lower the resolution of the host screen to match that of your less its monitor and

screen: display adapter al-
low the change

1 On the Options menu, click Remote Control Options. without restarting

Windows. The host
must also be run-
ning a version of
LapLink that sup-
3 Click OK. ports this feature.

2 On the Guest tab, check this box: Match Host to Guest.

Clearing the box restores the host to its original resolution.

Scaling the image of the host screen to fit You can also view the
entire host screen at once by scaling the image to fit within the LapLink
window. You always see all of the host’s screen, whether you are working
in full screen or window, though the image may be distorted.

To scale the image of the host screen to fit within your view:
B Press CTRL+SHIFT+S.
Pressing CTRL+SHIFT+S again restores the image to normal

E In full-screen view, you can also scale the image of the host screen by
clicking the icon in the host’s LapLink workplace which represents your
connection. Then click Guest Scale to Fit.
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Customizing keyboard control

By default, Windows system keys pressed on the guest computer take effect on the
host. If you want the system keys to operate on the guest while working in a Remote
Control window, click Remote Control Options on the Options menu. Then on the Guest
tab, click Execute on Guest. Through Remote Control Options, you can also change the
key combinations that control your view of the host.

Go to illustration >

v Windows system
keys are keys that
take effect in Win-
dows; other key
combinations, like
CTRL+Cor
CTRL+BREAK,
which affect DOS
sessions, are not af-
fected by LapLink
settings.

Windows system keys

Windows system keys are key combinations that perform a variety of
tasks. Pressing ALT+TAB, for example, switches to the program you used
last. By default, LapLink sends most system keys to the host during
Remote Control: pressing ALT+TAB on the guest, therefore, switches to
the program last used on the host.

You can make system keys work on your own computer (the guest) when
you are working in a Remote Control window.

E Windows system keys (except CTRL+ALT+DELETE) always take effect
on the host when you are using Remote Control in the full-screen view.

E If you intend to control a remote computer using the keyboard exclu-
sively (without a mouse), set the Windows system keys to execute on
your computer (the guest). When you want the keys to execute on the
remote computer (the host), switch to the full-screen view.

To execute Windows system keys on the guest:

1 Click Remote Control Options on the Options menu, and then click the
Guest tab.

2 Click Execute on Guest.
3 Click OK.

Remote Control shortcut keys

LapLink offers two shortcut keys to change your view of a host screen.
Pressing CTRL+SHIFT+F switches between full-screen and window view of
the host. Pressing CTRL+SHIFT+S switches between scaled-to-fit and nor-
mal view. (See the previous section for more information.)

You can change these default key combinations to certain other combina-
tions. (To avoid interference with other LapLink and Windows shortcut
keys, you are limited in your choice of replacements.)

To change the LapLink shortcut key combinations:

1 Click Remote Control Options on the Options menu.
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Customizing keyboard options in Remote Control Options

fiemotelContiollUptions K E3 When you are working in a Remote Control
Guest |Host I Startupl Performancel WindOW, the Windows system keys you
o press on your computer (the guest) take
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~ Windews System Keys rDOSFort—— If you prefer to have system keys take
¢ SendioHost dub = effect on your computer, click Execute on
% Execute on Guesk EAK Guest
— Sharteut K 7x12 . . .
FZLZ:EE??OQQE- 8¢ 8 With this option, you can change the short-
Full- 5 ®
ST — fu1E cut key that alternates between full-screen
ik Bx18 | and window view.
Scaling Toggle: }g ® 12 . . .
[Crivsnites - il = With this option, you can change the short-
Each character is: cut key that alternates between scaled to fit
— Bemate Contral Display B screen pixels wide and normal view.
¥ Always Use Full-screen 8 screen pikel: high
¥ Match Host to Guest

Defaults |
Ok I Cancel Apply | Help |

2 On the Guest tab, click in one of these boxes: < Go to topic summary

¢ Full-screen Toggle Changes the shortcut key that alternates
between full-screen and window view.

¢ Scaling Toggle Changes the shortcut key that alternates between
scaled-to-fit and normal view.

3 Press any of the following key combinations (where N is a number or a
letter):

SHIFT+ALT+N
CTRL+SHIFT+N
CTRL+ALT+N
CTRL+SHIFT+ALT+N
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Disabling the host keyboard and mouse and
blanking its screen

From a guest computer, you can ensure privacy and prevent interruptions by disabling
the host keyboard and its mouse and by blanking its screen. To perform any of these
“locking” operations from the guest, click the appropriate command on the Session
menu. On the host, you can allow locking by changing the default security setup.

Go to illustration >

v As a host, you
can keep guests
from changing your
locking and reboot-
ing settings during
Remote Control
sessions by setting
up password pro-
tection for your se-
curity system. For
more information,
see page 48.

Locking the host from the guest
With the permission of the host computer, you can:

O Blank the host screen The host’s screen is darkened, preventing
your work from being viewed at the host.

O Disable the host keyboard The host’s keyboard is locked, prevent-
ing anyone at the host from using the keyboard to interrupt your work.

O Disable the host mouse The host’s mouse is locked, preventing
anyone at the host from using the mouse to interrupt your work.

To lock the host during a Remote Control session:

B On the Session menu, click any of these commands to place a check
mark beside the command: Blank Host Screen, Lock Host Mouse, or Lock
Host Keyboard.

% To disable locking, click the command again to clear the check mark.

E If a command is dimmed, it is not available: either the host cannot per-
form the action, or the security setup of the host computer does not
allow it.

E Through Address Book, you can request the kinds of locking you want
to take effect as soon as you open a Remote Control session. Your
requests will be honored as long as they are allowed by the host. For
information on using Address Book to make connections, see chapter 2.

Configuring a host for locking

You can configure a host to determine who can lock it and how it will be
locked. Guests cannot lock the host without your permission, and locking
privileges you grant cannot be changed during a Remote Control session.

Whether you permit any kind of locking depends on how you intend to use
LapLink. If you want to use Text Chat, for example, there should be no
locking.
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Locking the host from the guest

v Blank Host Screen
v |Lock Hozt Mouse
v |Lock Hozt Keyboard

Reboot Hozt
To ensure privacy and pre- removes the check mark—
vent interruptions at the and the protection.
host, blank the host If commands appear
screen and lock its mouse dimmed on your Session
and keyboard. menu, the security setup
A check mark beside a on the host computer
command on the guest must be changed to allow
means the protection is in their use.
effect on the host. Clicking
the command again

You grant locking permission by changing the security setup on the host < Go to topic summary
computer: Click the Security button on the LinkBar. You then have a
choice:

O Set up a Log-in List by clicking Log-in List (Protected System) and add-
ing one or more entries. In each entry, check any of the three boxes
under Locking Permissions. The permissions will apply only to guests
whom you provide with the appropriate log-in name and password. For
more information about setting up a Log-in List, see page 48.

O If security is not an issue, open the system to any LapLink user by click-
ing Anybody (Public System). Check the Remote Control box, and then
check any of the three boxes under Locking. The permissions will apply
to all guests.
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Rebooting and logging on to the host

From a guest computer, you can reboot a host computer and restart Windows. To
reboot a host from the guest during Remote Control, click the Reboot Host command on
the Session menu. To configure a host for rebooting and restarting Windows, click
Remote Control Options on the Options menu.

Gotoillustration >  Rebooting the host from the guest

From a guest computer you may want to restart a host to put into effect
changes you have made on that computer. Or you may want to restart a
host computer to ensure that no one else can call in after you disconnect.

v If Reboot Host is To reboot the host from the guest during Remote Control:

dimmed on the Ses- . .
sion menu, the host B On the Session menu, click Reboot Host.

Egi ?gtalsliivt?:boorgt- You are then asked for confirmation. If you have not saved your work,

ing by a guest. you are asked if you want to do so before rebooting.

Logging onto Windows NT from the guest

Depending on how a Windows 95 or Windows 98 computer is set up, you
may or may not be prompted to log on to Windows. On every Windows NT
computer, however, you must always press CTRL+ALT+DELETE before you
can log on to Windows.

To send CTRL+ALT+DELETE to a Windows NT host, do one of
these:

B Press the key combination specified for this purpose on the host. (For
more information, see the next page.)

B On the host’s Session menu, click Send CTRL+ALT+DELETE to the Host.

B Click the Remote Control icon at the bottom of the host’s LapLink work-
place, and then click Feed CTRL+ALT+DELETE.

Configuring the host for rebooting

You must configure a host to allow any guest to restart it during a Remote
Control session. You can also require that the host be restarted whenever
a Remote Control connection is interrupted.

To configure a host computer for rebooting:

B On the Host tab of Remote Control Options (Options menu), check either
or both of these boxes:

¢ Allow Guest to Reboot on Command Check this box to allow
guests to restart the host using the Reboot Host command on their
computers.
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Rebooting the host from the guest in LapLink
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¢ Always Reboot When Guest disconnects Check this box to < Go to topic summary
require that the host be restarted whenever a guest breaks a con-
nection or the connection is broken accidentally.

Ensuring access to the host after a reboot

At the same time you are configuring a host for rebooting, you can config-
ure it so that a guest can resume a LapLink connection after the host is
rebooted. You can do this by setting up LapLink to run whenever Windows
is started.

To configure a host to so that it automatically runs LapLink each
time Windows is started:

B On the Startup tab of Remote Control Options (Options menu), check this
box: Always Start LapLink before Windows Logon Prompt.

Logging on to Windows NT When a Windows NT host requires the user
to press CTRL+ALT+DELETE at logon, a guest can press a special key
combination specified on the host.

To specify the key combination for CTRL+ALT+DELETE:

1 On the Host tab of Remote Control Options (Options menu), click in this
box: Send CTRL+ALT+DELETE to This Computer When a Guest Presses
This Key Combination.

2 Press one of these key combinations (where N is a number or letter):
SHIFT+ALT+N, CTRL+SHIFT+N, CTRL+ALT+N, or
CTRL+SHIFT+ALT+N.
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Hosting a Remote Control session

When you allow your computer to be controlled from a remote computer, your com-
puter becomes the host to a guest computer. For Remote Control to take place the host
need only be running LapLink—you do not need to be at the computer. Sensitive infor-
mation is protected by the conditions of the connection. You can grant greater access, or
limit these conditions, through the LapLink security system.

Go to illustration >

v To allow other
computers to con-
trol your computer
by modem or net-
work, you must re-
lax the security
setup established
during installation.
(See page 48.) The
only other action
needed in order to
become a host is to
run LapLink.

When you control a host, you control who can connect to that computer
and the kinds of services they can use. For example, you can limit a guest
to Remote Control only, or you can allow access to Text Chat and File
Transfer as well. You can even allow a guest to blank your computer’s
screen or disable the mouse and keyboard. All of these options are set in
the LapLink security system.

You can leave the host computer unattended, giving an authorized user
exclusive control. Or you can stay at the computer and interact with the
guest by trading off control. For example, the two of you could edit a doc-
ument together, participate in a training session, or explore a new pro-
gram.

& A host can be controlled by only one computer at a time. In the mean-
time, however, other computers can connect to the host using any
other services than Remote Control.

What you see on a host

When a guest connects to your computer and begins Remote Control, your
LapLink workplace is minimized. If you double-click the icon, the LapLink
workplace is restored to a window.

At the bottom of the restored LapLink workplace, you see an icon for the
Remote Control connection. The icon is identified by the name of the
remote computer. Clicking this icon displays a Windows menu with stan-
dard commands. Clicking Close closes the Remote Control connection.

; You can make the LapLink workplace remain a window when a guest
connects: Click Remote Control Options on the Options menu, and then
click the Host tab. Clear this box: Minimize LapLink When This Com-
puter Is a Host.

Reversing a Remote Control session

There may be times when the guest and you want to switch roles so that
you become the guest controlling the remote computer.

To reverse the direction of Remote Control, the current Remote Control
connection must be broken on either computer. Then, as the prospective
guest, you open a Remote Control window and begin controlling the other
computer.
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ey

-T! To avoid breaking the connection when a Remote Control connection is < Go to topic summary
closed, make sure that there is at least one other service window
open, such as File Transfer. If Remote Control is the only service in use,
open another service window before closing Remote Control.
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Sharing clipboard information with remote

computers

Computers in @ Remote Control connection share a common clipboard: you can copy
or cut information to the clipboard on one computer and paste this information on
another. Only information put in the clipboard during a Remote Control session is avail-
able to other computers.

Go to illustration >

When you cut or copy information for pasting in another document, the
information is stored temporarily in the clipboard. Normally, clipboard
information is transferred between documents on the same computer.
When you use Remote Control, however, you can use the clipboard to
transfer information from one computer to another. You can copy text or
graphics on the host computer, for example, and paste it on the guest.

If you are controlling several computers at the same time, information you
cut or copy on any of the linked computers can be made available for past-
ing on any of the others.

{l Only information placed in the clipboard during Remote Control can be
pasted on other computers. You cannot share any information copied or
cut to a clipboard before a Remote Control connection is opened.

; When you clear the contents of the clipboard on one computer, you
clear the contents of all the other clipboards as well.

Pasting from the clipboard during Remote Control

When you copy or cut information to the clipboard during Remote Control,
only a small part of the information is transferred to the other computer
immediately. The rest of the information is transferred when you paste.

To prevent the loss of information added to the clipboard from the remote
computer during Remote Control, paste the information before disconnecting.

If you are controlling several remote computers, information in the clip-
board on your computer is available to any of the remote computers. If
you want to transfer clipboard information from one remote computer to
another, however, you must first paste the information into a document on
your computer; then paste it into a document on another remote com-
puter.

Disabling clipboard sharing

Clipboard sharing is available during Remote Control sessions unless you
disable it.

To disable clipboard sharing:

1 Open a Remote Control connection to another computer.
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Sharing clipboard information during Remote Control

When you are controlling
another computer, the two
computers share a common
clipboard.

You can cut or copy text or
graphics on either computer
and paste it on the other.

Only information placed in
the clipboard during a
Remote Control session is
available to other computers.

2 On the Edit menu, click Link Clipboards to clear the check mark. < Go to topic summary

If there is data in the common clipboard that hasn’t been transferred
completely, you are asked whether to complete the transfer.

X To enable clipboard sharing again, repeat the procedure to restore the
check mark to Link Clipboards. Only data placed in the clipboard after
you enable this option can be shared with other computers.
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Customizing Remote Control performance

As a guest, you can change several Remote Control settings either to speed up perfor-
mance or to enhance your view of the host screen. When speed is your priority, change
the settings to enhance performance. When you want the best view of the host screen,
turn off the performance enhancements. To change performance settings, click Remote
Control Options on the Options menu, and then click the Performance tab.

Go to illustration >

v By default, Re-
mote Control per-
formance is
configured for the
Typical option. To
restore the original
settings, click Typi-
cal.

v To alter your view
of the host screen,
click the Settings
button in Remote
Control Options.

v Do not prevent
the display of large
bitmaps if you
intend to work in

a paint program
on the host.

To improve Remote Control performance, LapLink temporarily alters the
host screen by removing its wallpaper, screen saver, and other visual
enhancements. You can restore any of these enhancements. Or you can
improve performance even more by minimizing the number of bitmaps
and bitmap colors transferred over a connection.

To change Remote Control performance settings:
1 On the Options menu, click Remote Control Options.
2 On the Performance tab, click one of these options:

¢ Best Quality Improves the appearance of fonts and does not change
the appearance of the host screen except to disable its screen saver.

¢ Best Performance Displays smaller bitmaps in black and white
and does not show larger bitmaps at all; also changes the appear-
ance of the host screen to maximize performance.

¢ User Customized

3 To customize the settings for any of these options, click the Settings
button and change the settings on the Guest Display and Host Display
tabs as described below.

Changing your view of the host screen

On the Guest Display tab, you can change the quality of your view of the
host screen without affecting the host screen itself. Three of the settings
change the amount of information transferred to your computer and
therefore affect the speed of the connection.

Send Font Information Displays text and symbols on the guest com-
puter. Checking this box speeds display performance but may not present
the most accurate representation of text and symbols.

Use Solid Colors Displays solid colors instead of dithered, or patterned,
colors. Performance is not affected, but your view of the host may
improve.

Prevent Display of Large Bitmaps Determines the size of the largest
bitmap to be displayed in your view, ranging from 32 by 32 to 512 by 512
pixels. Choosing a smaller size improves performance but may cause bit-
maps not to appear in some dialog boxes, wizards, and buttons. (Experi-
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Customizing Remote Control performance

Remote Control Options
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Settings... |

ment with the setting, increasing it as necessary to display larger
bitmaps.)

Bitmap Color Selects the palette used to display bitmaps. The values
range from Monochrome to True Color (24 bit). Choose a palette with
fewer colors to improve performance.

Temporarily changing the host screen

On the Host Display tab, you can alter your view of the host by changing
the appearance of the host screen itself. When you disconnect, the host
screen is restored to its original appearance.

Don’t Show Active Desktop as Web Page Disables the View as Web
Page feature of Windows 98 and Internet Explorer 4.0. (Clearing this
option slows performance considerably.)

Don’t Show Any Background Wallpaper or Patterns Hides the wall-
paper and patterns that normally decorate the desktop of the host.

Don’t Animate Windows, Menus, or Lists In Windows 98 and Inter-

net Explorer 4.0, does not show animations of windows, menus, and lists.

Don’t Smooth Edges of Screen Fonts Disables font smoothing, which
makes large fonts look better on the screen.

Don’t Show Window Contents When Dragging or Sizing Shows
only the outline of windows dragged and sized on the host.

Disable Screen Saver Keeps the host’s screen saver from running.

< Go to topic summary

v The monitor and
the screen adapter
on both the guest
and host determine
the maximum num-
ber of colors that
can be viewed on
the guest.

v Keep all of the
Host Display boxes
checked for best
Remote Control
performance.
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Using Text Chat

Text Chat lets you exchange typed messages with a person sitting at a remote com-
puter. Used with a service like Remote Control or File Transfer or by itself, Text Chat is
useful for exchanging brief messages and sending instructions.

Go to illustration >

v A Text Chat win-
dow pops to the
foreground on your
screen whenever
the remote user
sends a message.
To keep the Text
Chat window from
activating automati-
cally, click Text Chat
Options on the Op-
tions menu. Then
clear this box: Re-
store Text Chat
Window Automati-
cally.

Opening a Text Chat window

When you connected to the remote computer, you may have opened a
Text Chat window. If not, you can open one after you open the connection.

To open a Text Chat window:

B Click the Open Text Chat button on the LinkBar. Or click Open Text Chat
on the Window menu.

£ If you have opened more than one connection, click a window for the
desired connection before opening Text Chat.

Sending messages
A Text Chat window consists of two parts:

O The upper part displays the messages you have sent to the remote user
as well as those the remote user has sent to you. Each message is iden-
tified by the name of the computer from which it was sent.

O The lower part serves as a note pad on which you write your messages.
It clears each time you send a message.

To send a message to the remote user:
1 Click the Text Chat window.
2 Type your message.

Avoid pressing ENTER until your message is complete. To start a new
paragraph, press CTRL+ENTER.

3 Press ENTER to send the message.

Pasting text into your Text Chat window

Instead of typing messages while connected, you can prepare them ahead
of time and paste them into the Text Chat window as necessary.

To paste text into a Text Chat window:

1 In Notepad or another Windows text editor, select the text and copy it.
2 In LaplLink, click the lower part of the Text Chat window.

3 Click Paste on the Edit menu.
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Using Text Chat
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Copying text from your Text Chat window < Go to topic summary
You can copy part or all of a Text Chat conversation and paste it into v To reverse your
another Windows program. latest editing action
in the lower part of
To copy your Text Chat conversation: a Text Chat window,

. - click Undo on the
1 In the upper part of the Text Chat window, highlight part of the text, or Edit menu.

select the entire conversation by clicking Select All on the Edit menu.
2 Click Copy on the Edit menu.

3 Switch to another Windows program, and paste the text into that pro-
gram.

I} As a guest during Remote Control, you can carry on a Text Chat conver-
sation with the host only by viewing the host screen in a window. (In
full-screen view, you cannot see your own Text Chat window.) To
arrange the Text Chat window beside the Remote Control window, click
Tile Side by Side on the Window menu.
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Using File Transfer—Overview

Once you have connected to another computer and opened File Transfer windows, you
are ready to transfer files between the computers. First, display your target, and then
select the files you want to transfer. If you want the files on both computers, copy them.
If you want to transfer the files to one computer and delete them from the other, move

the files.

Go to illustration >

v In Windows,
folder and sub-
folder are used in
place of directory
and subdirectory.

v To determine
which File Transfer
window is which,
look for the com-
puter name in the
title bar, at the top
of each window.

¥ You can also se-
lect a group of files
or folders by click-
ing at a right corner
of the group and
dragging to the op-
posite corner to
form a selection
box.

You can open File Transfer windows at the time you connect to a remote
computer. Or you can open File Transfer windows sometime after the con-
nection is made.

To open File Transfer windows:

B Click the Open File Transfer button on the LinkBar. Or click Open File
Transfer on the Window menu.

Two File Transfer windows appear: one for the remote computer, one for
your computer. Using these windows, you can view all the files on any
drive on both computers.

Step one: Display the target

Since you will be using the drag-and-drop method of copying and moving
files, first find your target and make it visible on your screen. A target is
the drive or folder you want to transfer the files to.

To display the target:

1 Identify the target window: it may be the window for your computer or
the remote computer—whichever you want to receive the files.

2 On the left side of the target window, double-click the target drive.

3 Click the target folder. Its contents now appear on the right.

4 If you are looking for a subfolder, click the plus sign (+) beside the
folder containing the subfolder. Then click the subfolder.

Step two: Select the files

In the opposite File Transfer window, select the files you'll be transferring
to the target you just displayed.

To select the folders and files you want to transfer:

B On the right side of the window, click the folder or file you want to trans-
fer.

B To select more than one item, do either of the following:

¢ Hold down CTRL as you click each item.
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Transferring files using drag and drop
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¢ To select two or more items listed next to each other, click the first < Go to topic summary
item and press SHIFT while you click the last item.

Step three: Drag and drop

Using the drag-and-drop method simplifies file transfers. Keep in mind the
difference between copying and moving: Copying puts a copy of the files
on the other computer, leaving the originals where they were. Moving puts
the files on the other computer, deleting the originals.

To drag and drop the selected files:

B To copy the files, hold down CTRL and your left mouse button as you drag
them to the target folder.

B To move the files, hold down SHIFT and your left mouse button as you
drag them to the target folder.

% If you drag without using CTRL or SHIFT, files are copied when you drag

to a different drive or computer and moved when you drag to another
location on the same drive.
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Navigating through drives and folders

Each File Transfer window is split into a left and a right side. The left side is designed for
navigating through drives and folders: click or double-click a drive or folder to open it and
display its contents. On the right side, you see the contents of the open drive and folder.
Commands on the View menu let you change the appearance and the order of the con-

tents.

Go to illustration >

v Want to locate a
particular folder or
file? Type the first
letter of its name.
The highlight moves
to the next item be-
ginning with that
letter. Typing the
letter again finds
the next occur-
rence.

v As an additional
navigational aid,
you can filter files
and folders accord-
ing to names and
dates. Only the
items that match
your filter criteria
are displayed. On
the View menu,
click Filter.

Follow these guidelines to navigate through the left side of a File Transfer
window:

O Double-click a drive or folder Opens and expands the drive or
folder, displaying its subfolders immediately below. (Double-clicking is
the fastest way to navigate downward in a hierarchy of folders.)

O Click a drive or folder Opens the drive or folder without expanding
it.

O Click a plus sign (+) Expands the drive or folder, displaying its sub-
folders immediately below. The drive or folder is not opened.

O Click a minus sign (-) Collapses the drive or folder, hiding its sub-
folders.

Changing the view

When you open a drive or folder, you see its contents—subfolders and
files—on the right side of the File Transfer window.

By default, the contents appear in Detail view: file name, size, type (based
on the MS-DOS name extension), modification date, and attributes.

To change the appearance of the items displayed on the right side
of a File Transfer window:

B On the View menu, click one of these commands: Large Icons, Small
Icons, or List.

Try the different views to find your preference. To return to the original
view, click Detail.
Sorting files and folders

Regardless of the view, you can rearrange the folders and files on the right
side of a File Transfer window according to name, size, date, and so on.

To change the order of files and folders:

B On the View menu, point to Arrange Icons; then click one of these com-
mands: By Name, By Type, By Size, By Date, or By Attributes.
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Navigating through a drive
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-5 If you are displaying files in Detail view, you can sort them by name, < Go to topic summary
size, type (file name extension), modification date, or attribute: click
the corresponding button at the top of a column. Clicking the same but-
ton again reverses the order.
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Selecting files and folders

On the left side of a File Transfer window, you can select only one folder at a time. On
the right side, you can select multiple folders and files. To select a single item, point to it
and click the left mouse button. To select several items in sequence, click the first item;
then hold down SHIFT while you click the last item. To select items out of sequence, hold
down CTRL while you click each one. You can also click Select All or Select By on the File
menu. To cancel an individual selection, hold down CTRL, and click the item.

Go to illustration >  You must select a folder or file before you can copy or move it. When you
select an item, its name and icon are highlighted.

You can select a single folder on either side of a File Transfer window. You
can select files and multiple folders only on the right side.

% By default, selecting a folder selects all of its files and its subfolders. To
change the default, click File Transfer Options (Options menu). On the
Filter tab, clear this box: Include Subfolders in Copies. (You can always
override this setting when you are asked to confirm a copy or move
operation.)

To select a single file or folder:

B Place the mouse pointer on its name or icon, and click the left mouse
button.

v If you want infor-  To select a group of items, do either of the following:

mation about your . . . . .
selections—such as B Click the first item, and press SHIFT while you click the last item.
the number of files

and the total size— M Click at a right corner of the group and drag to the opposite corner to

click Size of Selec- form a selection box.
F\l"oen;uon the File To select two or more items out of sequence:

B Press CTRL while you click the items.

To select all folders and files in the current folder:

B Click Select All on the File menu.

% To select everything on a drive, click the drive and then click Select All.
To select folders and files using the Select By command:

1 Click Select By on the File menu.

2 In the Filter box, type the name of a file or folder. Or use wildcards to
specify items with similar names.

For example, typing *.DOC selects all files with the .DOC extension. The
default (*.*) selects all files and folders.
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Selecting several files
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Select several items not listed
together by pressing CTRL while you
click the items.

Select a group of items by dragging
a selection box around them, from
right to left.

Or click the first item and then press
SHIFT while you click the last one.

You can specify several criteria at once by typing them one after < Go to topic summary

another and inserting a space or a comma between them. For exam-
ple, typing *.DOC,*.TXT displays all files with those extensions.

3 If you want to select according to date, check the Enable Date/Time
Range box. Then type the dates and times under Oldest File and Newest
File.

4 Click OK.

Clearing selections
To clear an individual selection:

B Hold down CTRL while you click the item.
To clear all selections:

M Click Clear Selection on the File menu.
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Copying or moving files and folders

Once you have displayed the target and selected the items to be transferred, you are
ready to use the Copy or Move command. Or you can use the mouse to drag the items
and drop them onto the target. Before the transfer is completed in either case, you see a
confirmation dialog box showing details of the operation you are about to perform. You
can then proceed immediately, change certain conditions, or cancel the operation

entirely.

Go to illustration >

v’ Before attempt-
ing to transfer be-
tween computers,
open a File Transfer
window for each of
them.

v For information
about copying and
moving files with
long names to Win-
dows 3.1, see page
94,

v Copy and Move
also appear as but-
tons on the Drive
Bar, near the top of
each File Transfer
window.

When you copy or move, you transfer items from one location—the
source—to another—the target. You can transfer items using the Copy or
Move commands or by dragging them with the mouse.

To prepare for a copy or move operation:

1

Navigate through the left side of the target window to display the folder
where you want to put the selections. Click the folder. (For more infor-
mation, see page 78.)

In the source window, select the items you intend to transfer. Make sure
that the source and the target are still showing. (For more information,
see page 80.)

To copy or move using drag and drop:

1

Place the mouse pointer over a single item or one of several items you
have selected on the source.

Do either of the following:

¢ To copy, press CTRL and your left mouse button as you move the
pointer over to the target folder.

¢ To move, press SHIFT and your left mouse button as you move the
pointer over to the target.

Once the target is highlighted, release the mouse button and the CTRL
or SHIFT key.

You now see the File Copy or File Move dialog, as described on the oppo-
site page.

To copy or move using a command:

B With the source still window active, click Copy or Move on the File menu.

You now see the File Copy or File Move dialog, as described next.
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Confirming a copy or move operation
2
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Tips for drag i Copy by pressing i Move by pressing
and drop — CTRL as you drag. SHIFT as you drag.
To complete the copy or move: < Go to topic summary

1 In the File Copy or File Move dialog box, you can verify the source and
the target, change the target, and set options. Do any of the following:

¢ Under To, verify the target. You can choose a different computer from
the Computer drop-down list; in the Folder box, you can type any
drive and folder already on the target.

¢ Under Options, check or clear the boxes as you wish. For more infor- ¢ When you trans-

mation, see the next section. fer folders that are
not on the target al-
2 Click OK to complete the operation or Cancel to halt it. ready, the folders

. . . . . are created for you.
You now see a dialog box reporting on the operation as it proceeds. Click  yoy do not have to

Cancel to halt the operation. If the Protected Files dialog box appears, create them your-
select the files you want to transfer, and click OK. self.

% Dropping onto a drive puts the selections at the highest level of the
hierarchy of folders.

% Dropping onto a folder puts the selections inside the folder.
$

Dropping onto a file puts the selections on the same level as the file.
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Setting File Transfer options for the results you want

Certain File Transfer options play a crucial role when you are copying or moving files.
Depending on how you set them, you can include or exclude subfolders, prevent the
overwriting of files except by newer copies, or copy only files you have backed up before.
To specify global preferences for these options, click File Transfer Options on the Options
menu; then click the Filter tab. Whenever you confirm a copy or move operation, you can
change the settings for that operation.

Go to illustration >

v Before transfer-
ring files between
computers, ensure
that their clocks are
reasonably in sync.
If they are not, files
that appear to be
older may actually
be newer, and you
could lose your
most recent work.

v Subfolders are al-
ways included when
you move a folder.

There are three File Transfer options that determine which files are trans-
ferred and which are overwritten:

O Transfer Only If Files Are Newer

O Include Subfolders in Copies

O Transfer Only If Files Are Already on Target

The first two options are in effect until you change them.

To change your global preferences for File Transfer options:

B Click File Transfer Options on the Options menu. Click the Filter tab, and
then check the appropriate boxes.

When you transfer files, you can tailor these options for that operation
before giving your confirmation.

Protecting newer copies of files

One of the options—Transfer Only If Files Are Newer—is designed to pre-
serve files that represent your most recent work. It is also useful for
speeding up file transfers; files that do not need to be updated are
excluded from the operation.

When the box is checked, Transfer Only If Files Are Newer ensures that
files are not overwritten by older copies of those files. (Files not already on
the target will be copied anyway.) When the box is cleared, files are over-
written without regard to their dates and times.

Including or excluding subfolders

One of the options—Include Subfolders in Copies—is designed for copying
a hierarchy of folders and subfolders and is potentially the most powerful
of the File Transfer options. It can make the difference between copying
hundreds of files or only a few.

When the box is checked, Include Subfolders in Copies extends your selec-
tion to include any subfolders within the folders you have selected. When
the box is cleared, your selection is limited to the selected files and folders
(including the files in those folders); subfolders within folders are
excluded.
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Setting options for copy and move operations
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Updating older copies of files < Go to topic summary

One of the options—Transfer Only If Files Are Already on Target—simpli-
fies the task of updating older copies of files without adding new ones. It is
designed for anyone who regularly updates the same set of files. No mat-
ter how many files you select on the source, only those already on the tar-
get will be copied; those not on the target will be ignored.

In preparation for using this option the first time, copy the files to the tar-
get with the box cleared. When you are ready to update the same files,
check the box.

Deleting to the Recycle Bin v Whether files are
By default, any files you delete from a hard drive are “recycled,” that is, ;eecr?ltﬂ,esegoe,zrdmig
moved to the Windows Recycle Bin, where you can retrieve them later. determined solely
(The Recycle Bin must be enabled for this feature to work.) You can by the setting on
change this setting so that all files are permanently removed when you the computer that
delete them in LapLink. (Files deleted from floppy disks and network opens the connec-

drives are always permanently removed.) tion.

To permanently remove files when you delete them in LapLink:
1 On the Options menu, click File Transfer Options.

2 On the Delete tab, clear this box: Move Deleted Files and Folders to the
Recycle Bin.
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Synchronizing folders with SmartXchange

U se SmartXchange to synchronize two folders in a two-way exchange of files. You can
limit the scope of the operation by including only the files already in both folders. You can
also use SmartXchange to update a backup folder quickly. In either case, older files are
overwritten, but no files are deleted.

Go to illustration >

v With Smart-
Xchange, you deter-
mine the items to
be copied by select-
ing the folder con-
taining the items,
not by selecting the
items themselves.
Select the folder on
the left side of each
File Transfer win-
dow.

v To verify which
folder is open, look
at the title bar, at
the top of the File
Transfer window.

v For information
about using Smart-
Xchange with a
Windows 3.1 com-
puter, see page 94.

Synchronizing folders

If you have ever copied files back and forth between computers so that
they share the latest files, you have synchronized. Unlike the usual copy
operation, synchronization works in two directions: from one folder to the
other and back again.

With SmartXchange, you can accomplish this in one operation, one folder
at a time. You can increase the scope of the operation by including sub-
folders within the folder. You can limit its scope by exchanging only the
files that are on both folders already.

| SmartXchange is a tool for exchanging files between folders. It does not

° merge the contents of files. If you need to merge databases, schedules,
or other shared files, see the documentation for the program in which
they were created.

-;- If you synchronize the same folders on a routine basis, consider using
Xchange Agent instead of SmartXchange. Xchange Agent automates
the process of opening connections, selecting the pairs of folders to be
synchronized, setting the appropriate options, initiating the exchange,
and disconnecting. For more information, see page 98.

To use SmartXchange to synchronize folders:

1 On the /eft side of each File Transfer window, click the folder (not an
entire drive) containing the files you want to exchange.

2 On the SyncTools menu, click SmartXchange. Or click the Sync button
on the Drive Bar, near the top of the File Transfer window.

3 Verify that the source and target are correct. If necessary, change the
target.

¢ If you want to include subfolders in the exchange, check this box:
Include Subfolders.

¢ If you merely want to update files—and not add new ones—check
this box: Transfer Only If Files Are Already on Target. If you want the
two folders to be identical, the box must be cleared.

4 Make sure that this box is cleared: One-way Transfer Only.
5 Click OK.
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Synchronizing folders
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already in both folders, check this i
box. Clear the box to copy all files
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a one-way transfer from source to " D e e
target, as when you update a
backup folder.

Updating backup folders < Go to topic summary

You can also use SmartXchange to simplify the process of updating a
folder to which you have backed up a set of files.

To use SmartXchange to update a backup folder:

1 On the left side of the target (backup) window, click the folder you want
to update.

2 On the /eft side of the source window, click the folder containing the files
you want to back up again.

3 On the SyncTools menu, click SmartXchange.

4 Verify that the source and target are correct. Change the target if nec-
essary.

¢ If you want to include subfolders in the exchange, check this box:
Include Subfolders.

¢ If you want to update files—and not add new ones—check this box:
Transfer Only If Files Are Already on Target. If you want the folders to
be identical, the box must be cleared.

5 Make sure that this box is checked: One-way Transfer Only.
6 Click OK.



88

Chapter 4

Replacing one folder with another: Clone Folder

C lone Folder replicates one folder onto another by adding, deleting, and updating files
on the target until they match those on the source. After opening the target and the
source folders, click Clone Folder on the SyncTools menu. Then choose whether to
include or exclude subfolders.

Go to illustration >

v With Clone
Folder, you deter-
mine the items to
be copied by select-
ing the folder con-
taining the items,
not by selecting the
items themselves.
Select the folder on
the left side of each
File Transfer win-
dow.

v For information
about using Clone
Folder with a Win-
dows 3.1 computer,
see page 94.

Clone Folder replaces one folder (the target) with another (the source).
The effect is the same as deleting everything on the target and copying
everything from the source.

Cloning a folder adds and updates target files until they are identical to
those on the source. In addition, it deletes any target file that has no
counterpart on the source.

It’s the deletion of files that makes Clone Folder useful, particularly when
you are maintaining a backup folder. With the usual copy operation, the
backup folder over time accumulates all the files you have deleted from
the source. With Clone Folder, those unwanted files are removed with each
backup.

| Use this command with caution. Any subfolder or file not on the source
* will be deleted from the target.

To replace one folder with another:

1 On the /eft side of the target window, click the folder whose contents
you want to replace.

2 On the /eft side of the source window, select the folder whose contents
you want to reproduce.

3 With the source window still active, click Clone Folder on the SyncTools
menu.

4 Verify that the source and target are correct. Change the target if nec-
essary.

5 If you want to reproduce subfolders within the selected folder, check this
box: Include Subfolders.

6 Click OK.
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Using Clone Folder to replace one folder with another
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Clone Folder deletes any files in the target folder that are
not included in the source folder. It then updates older files
on the target.

< Go to topic summary
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Speeding file transfers with SpeedSync and
compression

When you are updating files, SpeedSync can shorten transfer times by sending only
the parts of the files that have changed since the last update. SpeedSync is most effec-
tive when you update files that have not been changed extensively since the last update.
Compression, on the other hand, speeds file transfers by “shrinking” files before they are
sent and restoring them to their original sizes afterward. Compression is most effective
with large files that have not been compressed already. Though both features are in
effect by default, there may be circumstances in which you might improve transfer times
by disabling them.

Go toillustration »>  Using SpeedSync

SpeedSync is designed to cut transfer times when you are updating files.
It has no effect when you are copying files that were not on the target
before you started copying.

v Whether Speed- Before a file is copied, SpeedSync searches the target for a file with the
Syncand compres-  same name. If none is found, the entire file is copied. Otherwise, the two
sion are used infile  fjles are compared to locate changes in the source file. Only the changes

transfers depends : . .
entirely on the set- located in the source file are copied.

tings of the guest The time necessary to locate changes is usually more than offset by the

(the computer that  g5)1er amount of data that has to be transferred. The reverse may be

opens the connec- . . . - .

tion). true in a few circumstances, particularly when you are updating files over
a fast network connection.

| SpeedSyncis a tool for decreasing transfer times. It does not merge the

® contents of two files. The contents of one file will always replace the
contents of the other. If you need to merge databases, schedules, or
other shared files, see the documentation for the program in which they
were created.

To disable SpeedSync:
1 On the Options menu, click File Transfer Options.

2 On the Performance tab, clear this box: Use SpeedSync on All File
Transfers.

E To review the effect of SpeedSync on your past file transfers, open at
least one File Transfer window. Then click SpeedSync Statistics on the
SyncTools menu. You see the statistics for your most recent transfer as
well as combined statistics for earlier transfers.
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How SpeedSync works

With SpeedSync Without SpeedSync
Source and target files are compared to Source and target files are not compared
locate changes in the source file. for changes.
Only changes are copied. The result is Entire files are copied, often resulting in
often shorter transfer times. longer transfer times.
Using compression < Go to topic summary

Because compression usually results in the transfer of less data, it is par-
ticularly useful when you transfer large files by modem: the larger the
files, the greater the savings.

Since compression would actually slow the transfer of files that have
already been compressed (by PKZIP or another file-compression pro-
gram), LapLink automatically turns this feature off while it is transferring
such files.

If you find a situation in which compression does not speed up file transfer,
you can disable it: On the Options menu, click File Transfer Options. On
the Performance tab, clear this box: Use Compression When Transferring
Files.
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Resuming an interrupted file transfer

lf you lose your connection to another computer while transferring files, File Transfer
Recovery lets you connect again and continue the transfer where it left off. Any file—or
portion of a file—copied before the interruption is skipped; only the untransmitted data is

copied.

Go to illustration >

File Transfer Recovery lets you continue a file transfer even when you have
lost a connection. Instead of starting the transfer at the beginning, File
Transfer Recovery resumes at the point where the connection was lost:

O Only the missing part of the interrupted file is copied.
O Files successfully copied before the interruption are not copied again.

{l File Transfer Recovery is particularly useful when you copy large files
over an unreliable modem connection.

To resume an interrupted file transfer:

B If you were running an Xchange Agent when the interruption occurred,
run the agent again.

B If you were transferring from File Transfer windows:
1 Re-establish the connection.
2 Select the same files and folders.

3 Begin the transfer again.

File Transfer Recovery and other options

Three options must be enabled for File Transfer Recovery to work effec-
tively. All three appear in File Transfer Options (Options menu) and are
enabled by default.

Enable File Transfer Recovery Located on the Copy/Move tab, this box
must be checked for File Transfer Recovery to occur at all.

Use SpeedSync on All File Transfers Located on the Performance tab,
this box must be checked to allow the transfer to resume with the missing
part of a file. When it is cleared, the entire file must be sent again.

Transfer Only If Files Are Newer Located on the Filter tab, this box
must be checked so that files successfully copied before the interruption
are not copied again.
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How File Transfer Recovery works

If you lose a connection while transferring a file, the
data transferred at the point of interruption is stored
on the target computer

> iliﬁ: 1
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When you reconnect and resume The operation concludes with the
the transfer, the missing part of transfer of any files that had not
the file—not the entire file—is been copied before the connection
copied. was lost.

When a transfer is interrupted, File Transfer Recovery creates a file in the < Go to topic summary
target folder containing whatever part of the file has been transferred
successfully. The file is named !LAPLINK.TSI.

When File Transfer Recovery resumes a transfer, this file is compared with
the source file to determine what’s missing. Once the file is complete,
ILAPLINK.TSI is given its original name. (If you do not use File Transfer
Recovery to resume the transfer, the file remains in the folder and can be
deleted.)
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Transferring files with long names to Windows 3.1

Transferring files with long names to a Windows 3.1 computer or to some other target
that does not support long file names requires that the names be shortened. In LapLink,
you can rename them yourself, leave them to LapLink to rename automatically, or omit
them from the transfer. SmartXchange and Clone Folder are of limited use when
exchanging files with a Windows 3.1 computer.

Go to illustration >

Windows 95, Windows 98, and Windows NT give you the flexibility of nam-
ing files pretty much as you want them: you are not limited to eight char-
acters with a three-character extension. LapLink fully supports the long file
name feature. File names appear in their entirety in File Transfer windows,
and, with the exceptions noted next, you retain the long names when you
transfer the files.

Long file names pose a problem only when you transfer them to a target
that does not support long file names. Such targets include—

O A computer running Windows 3.1

O A computer running LapLink for Windows 6.0, in Windows 3.1 or Win-
dows 95

O Older networks

Using Copy and Move

If you copy or move a file with a long name to a target that does not sup-
port long file names, LapLink automatically detects the situation and dis-
plays a dialog box giving you these options:

O Create a short name yourself
O Let LapLink rename the file for you
O Skip the file entirely

If there are several files with long file names, you can click Automatic to
let LapLink create short names for all the long-name files at once.

How LapLink automatically assigns short names The short name
LapLink assigns to a file depends on the long file name and the number of
times the long file name has been transferred to a particular target, as
illustrated in the following examples:

File name
Original LongFileName.DOC
On first transfer to target LongFile.DOC
On second transfer to target LongFil1.DOC

On third transfer to target LongFil2.DOC
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Transferring long file names to Windows 3.1

Create Short File Names m

The target does not suppont long file names. Type 0K
& new short name, or click OK to accept the
proposed name.

When you transfer a
long file name to a tar-
get that does not allow
long file names,
Automatic LapLink suggests a

Click Automatic to create new shart names for all shorted version of the

e

the files in the transfer. Skip name. You can then
. ® Click OK to accept
Cerillet @ie Cancal the suggested name.
Source Path: ® Revise th
iy Documentsihy ACCOUNTS XLS evise the name
Help and click OK.
T_E”GEt Folder: @ Click the Automatic
CATEMP button to let LapLink
Mew short name: rename the files.
® Click the Skip but-
ton to proceed without

transferring the file.

When you let LapLink assign short names in repeat transfers to the same < Go to topic summary
target, you create new files instead of overwriting old ones. To prevent this

accumulation of files, rename the source files, assigning only short names.

Or assign the short names yourself when LapLink displays the Create Short

File Names dialog box; be sure to assign the same name in each transfer.

Using SmartXchange

Since SmartXchange is intended as a two-way exchange of files, it is of
limited use in synchronizing files with long names when either the source
or the target does not support long names.

SmartXchange is completely disabled when there are long file names on v If you want

the source and the target does not support them. (LapLink detects this sit- SmartXchange to

uation and displays a message informing you of the situation.) work as intended,
give all files short

SmartXchange is reduced to a one-way transfer when there are long file names before syn-

names on the target and none on the source. (LapLink automatically chronizing.

detects the situation and displays a message informing that you can copy
files only from the source to the target.)

Using Clone Folder

You can safely use the Clone Folder feature to clone folders in all circum-
stances except one: when you are trying to replicate a source containing
files with long names onto a target that does not support long file names. In
such circumstances, use Clone with caution; you may lose files from the tar-
get even if they are newer than their long-name counterparts on the source.
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Introduction to Xchange Agent

XChange Agent automates synchronization—the process of keeping your files updated
when you use two computers. To set up an Xchange Agent, open a connection to another
computer, choose the pairs of folders to be synchronized, preview, and then perform the
synchronization. After working on the files on either or both of the computers, run the
agent to reconnect and update the older copies of the files automatically. You can run an
agent by double-clicking its shortcut icon or by scheduling it to run unattended.

Go to illustration >

v Xchange Agent
automatically picks
the newer copies of
all the files regard-
less of which com-
puter they are on.
Files that have no
match are copied
onto the computer
that lacks them.

v Xchange Agent is
also useful for local
synchronizations, as
when you want to
keep files on your
desktop in sync with
files on your corpo-
rate network.

Xchange Agent simplifies the repetitive process of keeping two comput-
ers—often a laptop and a desktop—in sync.

Whether your most recent work appears on one or both of the computers,
Xchange Agent transfers files so that both have only the newer copies of
your files.

Xchange Agent automates the process of opening connections, selecting
the pairs of folders to be synchronized, setting the appropriate options, ini-
tiating the exchange, and disconnecting. To prevent unwanted results, you
can preview beforehand.

Creating an Xchange Agent

Open a LapLink connection—by modem, network, or any other means—to
the computer with which you want to exchange files.

Then use the Xchange Agent wizard to create your own Xchange Agent:

O From the hierarchy of folders displayed for each computer, choose the
pair of folders—one folder on each computer—you want to synchronize.
Choose as many pairs as you want.

O Name your Xchange Agent file and save it.

O Preview the agent you just created, making sure that you set it up as
intended.

Then run the agent to make the files in each pair of folders identical.

Previewing an Xchange Agent

To prevent unintended consequences, you can preview an agent before
synchronizing. The preview screen shows pairs of folders and files, with
arrows to indicate the direction in which files will be copied when the agent
is run.

In a preview, you can customize the agent by excluding pairs of files (and
entire folders) from the current synchronization, leaving the files as they
are on each computer.
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Choose folders to synchionize
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You can also run an
agent from the desk-
top or by scheduling
it

5 By default, agents are previewed before being run. To bypass pre-

< Go to topic summary

view, click Properties on the File menu and click an option on the Run

Options tab. For more information see page 107.

Running an Xchange Agent

There are several ways to run an Xchange Agent:

O Double-click its shortcut icon on the desktop.

O Schedule the agent to run unattended.

O Start LapLink and run the agent.

O Double-click the agent file in Windows Explorer.

Beyond the basics

v’ Xchange Agent
exchanges files be-
tween folders. It
does not merge the
contents of files. To
merge databases
and other shared
files, use the pro-
gram in which the
files were created.

Xchange Agent offers various options for customizing each synchroniza-

tion. For example, you can—

O Change the direction of copy: instead of a two-way change of files, files
are copied in one direction only, from one computer to the other.

O Include or exclude (filter) files according to type or name.

O Include or exclude subfolders within synchronized folders.
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Creating an Xchange Agent

Once you connect to another computer, you create an Xchange Agent by selecting the
pairs of folders—one folder on each computer—which you want to keep synchronized.
You can select the pairs from a window displaying the folders on both computers, or you
can drag folders from File Transfer windows onto the Xchange Agent window. In either
case, you can preview the agent to ensure that you have set up the synchronizations as

intended.

Go to illustration >

v There are two
“modes” in Xchange
Agent: edit and pre-
view. Certain opera-
tions are available
in one mode and
not the other. To
save an agent, for
example, you must
be in edit mode. To
change to edit
mode from preview
mode, click the
Close Preview but-
ton on the toolbar.

To create an Xchange Agent:

1 Start LapLink and open a connection with the computer with which you
want to synchronize files.

For a local synchronization, simply start LapLink.
2 On the SyncTools menu, click either of these:

¢ Xchange Agent Wizard

¢ New Xchange Agent

Using the Xchange Agent wizard

The wizard guides you through the process of selecting pairs of folders to
be synchronized. After naming and saving the agent file, you can preview
the agent and change its settings.

To make the files in each folder pair identical, click the Run button on the
toolbar.

Using New Xchange Agent

After choosing New Xchange Agent from the SyncTools menu, you can
select the pairs of folders to be synchronized in two ways:

O On the Edit menu, click Add Folder Pair. After specifying whether the
synchronization is Local-Local or Local-Remote, click a folder on each
side of the window. Repeat the procedure to add other folder pairs.

O Drag folders from File Transfer windows onto the Xchange Agent win-
dow. Drag a folder first from one File Transfer window, then from the
other one. Repeat the procedure to add other folder pairs.

Once you have selected the pairs to be synchronized, you can do any of
the following:

O Preview the agent: click the Preview button on the toolbar.

O Name and save the agent file: On the File menu, click Save. In the File
Name box, type a name, and click OK.
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Selecting folder pairs for synchronization
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O Run the agent to make the files in each folder pair identical: click the < Go to topic summary
Run button on the toolbar.

% Xchange Agent files are given the .LLX extension. In Windows 95 and
Windows 98, they are stored in the My Documents folder. In Windows
NT, they are stored in the \Profiles\yourname\Personal folder within the
Windows folder (where yourname is your Windows NT logon name).
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Previewing and running an Xchange Agent

Previewing an Xchange Agent lets you see exactly which folders will be synchronized
and which files will be overwritten. It also lets you skip pairs of folders and files and
resolve conflicts. Unless you specify otherwise, you preview each agent before you run it.
You can run an agent from the desktop, from within LapLink, or you can schedule it to
run in your absence.

Go toiillustration >  Previewing

¢ Only agents that By default, a preview appears whenever you run most Xchange Agents.

you schedule to run  You can also open an agent and preview it.
unattended will pro-
ceed without a pre-  To open and preview an Xchange Agent:

view. To set up . .
other agents to run 1 In Laplink, click Open Xchange Agent on the SyncTools menu. (In

without a preview, Xchange Agent, click Open Xchange Agent on the File menu.) Then click
see page 107. the agent file and click Open.

2 Click the Preview button on the toolbar.
v In a preview, ar- While previewing an agent you can do any of the following:

rows indicate the di- ) . .
rectioninwhichfiles © Select files or folders to be omitted from the current synchroni-

will be copied, and zation only Click a pair and click the Skip Pair button on the toolbar.
thus which files will Skipping a folder skips all the files and subfolders it contains.

be overwritten.

Special icons indi- O Put skipped pairs back into a synchronization Click a skipped
cate conflicts be- pair and then click the Undo Skip button on the toolbar.

tween files.

O Resolve conflicts Click a pair showing a conflict icon, click the
Resolve Conflict button on the toolbar, and specify how you want the
conflict resolved. For more information about resolving conflicts, see
the next section.

| Once you have resolved conflicts or marked pairs to be skipped, run the
° agent before closing preview. Your modifications will be lost otherwise.

E To select every pair of folders and files in the agent, click Select All on
the Edit menu.

% To locate a pair with a conflict, click the Next Conflict button on the tool-
bar.

To close a preview:
B Click the Close Preview button on the toolbar. You are now in edit mode.

{l While in edit mode you can customize an agent in several ways. For
more information see page 106.
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Previewing an Xchange Agent
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Running an Xchange Agent < Go to topic summary

There are several ways to run an Xchange Agent:

O Double-click the agent’s shortcut icon on the desktop. To create a short-

cut icon for an open agent, click Create Desktop Shortcut on the File
menu.

O Schedule the agent to run at an appointed time. For more information v For a record of

see page 110. your latest synchro-
nizations, refer to
O Run the agent from within LapLink: Click Run Xchange Agent on the the LapLink log file:
SyncTools menu. Then click the name of the agent file and click Open. on the Options

menu, click Log-
O Run an agent you have opened in Xchange Agent: click the Run button  ging.

on the toolbar.
O In Windows Explorer, double-click the agent file.

Once an agent finishes synchronizing files, the connection with the remote
computer is closed. If LapLink was not running to begin with, it is shut
down automatically.
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Previewing and running an Xchange Agent
Dealing with conflicts

When you are keeping folders on two computers in sync, the most common kind of
conflict occurs when a file has been modified on both computers since the last time you
synchronized. You can handle these conflicts when you preview or run the agent. Or you
can set options to handle them automatically.

Go to illustration >

Conflicts between files

Conflicts occur when you modify a file on both of your computers. Since
both files are new, you need to decide how to handle them. These are the
choices you can make while previewing or running an Xchange Agent:

O Copy either the older or the newer file over the other.
O Copy either the older or the newer file and give the copy a new name.
O Skip the conflict, without copying either file.

When you skip a conflict, you carry it over to future synchronizations.
There are now two categories of conflicts:

O New conflicts Files have been changed on both computers since the
previous synchronization.

O oOld conflicts Conflicts were left unresolved in earlier synchroniza-
tions. The two computers now have different versions of the same file,
and both are dated prior to the latest synchronization. You can treat
these conflicts like new conflicts, or ignore them and let both versions
remain.

Changing how all conflicts are handled By default, each conflict is
presented for resolution when you run an Xchange Agent. You can change
this so that conflicts are handled automatically.

To change how conflicts are handled by an Xchange Agent:
1 Open the Xchange Agent.
2 On the File menu, click Properties.

3 On the Run Options tab, click this option: Run Unattended, without Pre-
view or Confirmation. Then click either of these options:

¢ Do Not Copy Either; Keep Both Files
¢ Copy the Newer File over the Older

Ignoring old conflicts By default, old and new conflicts are treated
alike, according to the settings on the Run Options tab in Properties. For
example, if you specify that conflicts are to be displayed every time you
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Resolving a conflict between files
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following:
i~ Cassi he Office Cassin at Home .
assin nhe Hife s st ok |- Copy the newer file over the
File:  LLASM.DOC File: LLESO1.0OC Ider Wlth the option Of iv-
Date:  B/24/95 2:25:46 PM Date:  B/25/96 2:24:04 AM Nest | _O ! P 9
- - g ing the copy a new name.
Size: 0 Bytes Size: 0 Bytes

Cancel_| | — Copy the older file over the
newer, with the option of giv-

Help .
Lo E;’;@/ L | ing the copy a new name.
€ Copy Dlder Fie Ere=cepy. | Skip the conflict, without

" Skip this pair. Da nat copy either file. copying either. You will then
retain two versions of the
‘ file, one on each computer.

— Resolution

Thiz ¥change Agent was last wun at: B/24/96 2:26:45 P

run an agent, old conflicts will appear every time you run the agent. The < Go to topic summary
alternative is to exclude old conflicts, regardless of how other conflicts
are handled.

To exclude old conflicts from synchronizations:
1 Open the Xchange Agent.
2 On the File menu, click Properties.

3 On the Advanced tab, click this option: Exclude Previously Skipped Files. ¢ To retain both
versions of files in

Other conflicts old conflicts, click
this option on the
You will encounter other kinds of conflicts in these situations: Advanced tab in
) . . Properties: Exclude
O When you attempt to copy a file or folder with a long name to a drive Previously Skipped
that does not accept long names. Files.

O When you attempt to synchronize a file with a folder; this happens only
when a file and a folder have exactly the same name.

Long name conflicts If you do not shorten long names, you are given
this choice when you run an agent: copy the file and give the copy a short
name, or skip the conflict without copying the file.

Conflicts between files and folders If you do not rename the file to
avoid the conflict, you are given this choice when you run an agent: copy
both the file and folder and give the copies new names, or skip the conflict
without copying either.

The best way to handle either of these conflicts is to rename files: shorten
the long names or rename the file so that it does not conflict with the

name of the folder. True synchronization cannot occur otherwise. If you set
an agent to run unattended, for example, neither file in a conflict is copied.
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Customizing an Xchange Agent

lnstead of a two-way synchronization, you can customize an agent so that files within
folder pairs are copied in one direction only, from one computer to the other. Among
other modifications, you can create a shortcut icon to run an agent directly from the
desktop, run an agent without a preview, and limit synchronizations just to the files that
already appear on both computers.

Go to illustration >

v To customize an
agent, you must be
in edit mode. If you
are previewing,
click the Close Pre-
view button on the
toolbar.

v To delete a pair of
folders, click the
pair and click Delete
Pair(s) on the Edit
menu. Then click
Yes. The folders are
deleted from the
agent, not from the
computers.

To customize an agent, you must open it from within LapLink or Xchange
Agent.

To open an agent:

B In LapLink, click Open Xchange Agent on the SyncTools menu. Click the
agent file and then click Open.

B In Xchange Agent, click Open Xchange Agent on the File menu. Click the
agent file and then click Open.

Changing the direction of copy

When you create an Xchange Agent, all folder pairs are set for a two-way
exchange of files. Files are copied in both directions, until the folders on
both computers are identical.

You can modify this by specifying that files in a folder pair be copied in one
direction only, so that only one folder updates the other.

To change the direction in which files are copied in a folder pair:
1 Click the folder pair.

To change the direction of copy for all folder pairs, click Select All on the
Edit menu.

2 Click an arrow button on the toolbar to change the direction of the copy.

Adding folder pairs

To add a pair of folders to an Xchange Agent:

1 Open a connection with the computer with which you are synchronizing.
2 On the Edit menu, click Add Folder Pair.

3 Click one folder for each computer and then click OK.

Changing how an Xchange Agentis run
There are several ways to customize how an agent is run:

O Create a shortcut icon for running an agent from the desktop: on the
File menu, click Create Desktop Shortcut.
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Changing the direction of copy

" ¥change Agent - C:\winNT\tsi324D ataVAdLib Project. LLX
File Edit Preview DOptions Help To change the

direction of copy,

Dl |E @ T ”l"lﬁ@ click one or more

Cassin in the Dffice Cassin at Home of the folders.

Then click either

(3 C:\My Documents 4b 7 D-thdu Document the left or rlght

L3 CMPropozals 4% 1 D:\Future Projects arrow button to
specify the direc-
tion.

For Help, press F1 EDIT él

O Schedule the agent to run at the time you want: on the File menu, < Go to topic summary

click Schedule. For more information see page 110.

O Set up the agent to run unattended: On the File menu, click Properties. ¢ For more infor-
On the Run Options tab, click this option: Run Unattended, without Pre- ~ mation about han-
view or Confirmations. Then determine how conflicts will be handled by ~ dling conflicts, see
clicking either of these options: Copy the Newer File over the Older or E!’;enprewous sec-
Do Not Copy Either; Keep Both Files. )

Changing which files are included in synchronizations

By default, subfolders within folder pairs are included in synchronizations. v Filters offer an-
Read-only files are also included, but hidden files and system files are not.  other way of deter-
To change these settings, click Properties on the File menu. Then click the ~ Mining which files

File Options tab and change the settings as necessary. gﬁéﬁr%en;;g‘fodnesd in

Also on the File Options tab, you can set an option to limit synchroniza- For more informa-
tions by exchanging only files that already appear on both computers. To  ton, see the next
exclude files that have been added to one computer and not the other, section.

check this box: Include Files Only If They Are Present in Both Folders.

% Instead of changing the various options every time you create a new
agent, you can set default options to apply to any agents you create in
the future. These defaults will take effect in new agents unless you
specify otherwise in Properties. To change the defaults, click Properties
for New Agents on the Options menu.
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Using filters to include or exclude files

Using preset filters or filters you create yourself, you can limit synchronizations by
including only certain files or types of files. Or you can use the same filters to exclude
certain files and file types.

Go to illustration >

v You can use
Xchange Agent to
synchronize a sin-
gle file: First, cre-
ate an agent to
include only the
folder pair contain-
ing the file. Then
create a filter to
specify the name of
the file.

Xchange Agent is shipped with filters for some of the most common types
of files, including Microsoft Word, Lotus 1-2-3, and dBase. File types are
defined by one or more extensions. Word files, for example, are defined by
the extensions .DOC and .DOT.

You can also create your own filters for different file types—or for specific
files.

You can use filters to synchronize only the files matching the filters. Or you
can exclude the files matching the filters and synchronize the rest of the
files.

To filter files by type using the preset filters:
1 Click a folder pair, and then click Set Filter on the Edit menu.
To filter all folder pairs, click Select All on the Edit menu.

2 In the list of available filters, click a filter and then click the Add button.
Repeat the process to add other filters.

3 To use the filters to exclude—not include—file types, check this box:
Exclude Files That Match These Filters.

4 Click OK.

To create and apply your own filter:

1 Click a folder pair and then click Set Filter on the Edit menu.
2 Under the list of available filters, click the New button.

3 In the Filter Name box, type a description for the filter.
4

In the Pattern(s) box, type one or more file extensions or file names,
using a semicolon (;) to separate them.

To specify file types, use extensions preceded by asterisks: *.chp;*.sty
and so on. To specify certain files, type their entire names:
annual.xls;march.xls;april.xls and so on.

5 Click OK.
Your filter now appears in the list of available filters.
6 Click the filter and then click the Add button.
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Adding a filter to include or exclude files

Set Filter EHE

%\' Add filters to choose the typesz of files included in the synchranization. Only
X . ~ [liles that match the active filters will be sunchronized.
Select the filter in the

list of available filters, | vaiale fiters Agtive fiters

Click the Add button. ACT! =] Internet documents
Sl
By default, filters Application Estenzions
include only the Bitmap images (I
matChing files in syn- Eft documents 4lﬂemuve

chronizations. To Lotus 1-2-3 Files
exclude the matching —_|Lotus Uftg;nlz'?'
files—and synchronize oo

- ticrosoft Exd LI
the rest—check this =
box. Mew... Edit... | Delete | Exclude files that match these filkers
0k Cancel Help
7 To use the filters to exclude—not include—file types, check this box: < Go to topic summary

Exclude Files That Match These Filters.
To remove the effects of a filter:
1 Click the filter in the list of active filters.
2 Click the Remove button.

Modifying a filter

You can modify any of the filters appearing in the list of available filters. To
apply the modifications, you must add the filter to the list of active filters,
even if the filter already appears in that list.

To edit and apply a filter:

1 Click the filter in the list of available filters.

2 Click the Edit button.

3 Change the Filter Name or Pattern(s) as necessary and then click OK.
4 In the list of available filters, click the filter then click the Add button.

-Tl To delete an available filter, click it and then click the Delete button.
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Scheduling an Xchange Agent to run automatically

You can schedule an Xchange Agent to run at a certain time on the days you specify.
Scheduled agents run unattended: there is no preview, and conflicts are handled auto-
matically. To schedule an agent, open it from within LapLink or Xchange Agent. To run
the agent on schedule, simply leave your scheduler running.

Go to illustration 3>

v Xchange Agents
can't be scheduled
using the Task
Scheduler in Win-
dows NT 4.0.

You can set up an Xchange Agent to run at a particular time on one of
these schedules:

O Just once, on a particular date (such as June 27, 1999)

O Every day

O On certain days of the week (such as Monday and Friday)

O Once a month on a particular day (such as the first day of each month)

LapLink does not have to be running for an agent to run as scheduled.
When the scheduled time comes, LapLink starts, the connection is opened,
files are synchronized, the connection is closed, and LapLink shuts down.

LapLink sets up an Xchange Agent to run at a scheduled time by setting it up
in a scheduler program running in Windows. If you have either of the follow-
ing scheduler programs, it will be used to run scheduled Xchange Agents:

O The System Agent program included in the Microsoft Plus! Companion
for Windows 95

O The Task Scheduler program included in Microsoft Internet Explorer

Otherwise, the LapLink Scheduler program (installed by LapLink) is used.
The LapLink Scheduler icon appears at the right end of the Windows task-
bar.

To schedule an Xchange Agent:
1 From within LapLink or Xchange Agent, open the agent.
2 On the File menu, click Schedule.
The Schedule Wizard begins.
3 Give a name to the schedule file.
4 Fill out the schedule by specifying the time and frequency.

-;- Once you have scheduled an Xchange Agent in LapLink, you should
modify it in your scheduler program, not in LapLink.

E To create another schedule for the same agent repeat the above proce-
dure and assign a different name to the schedule file.
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Scheduling an Xchange Agent from within LapLink
Set the time Whattime do you want to run the Xchange Agent?
when the
agent will Time: 3 = o = v 7]
run.
Click one of How often do you want to run the Xchange Agent?
these " Every day
options to
set the fre- & Onthese days: W don ™ Tue W Wed -
quency. I Fi [~ Sat I Sun
 honthly, on day: |22 3:
© Ongeon |l | oo frem =
< Back I et > I Cancel |
i
100% | lelEllE‘]l 4| The icon for LapLink Scheduler
appears in the lower right cor-
@Xch&mge Agent-C... | ‘CII Qm—ﬂﬁ-ﬁ&ﬂi ner of your screen after you
install LapLink.

To run a scheduled agent: < Go to topic summary

B Leave your Windows operating system and your scheduler running.

Running an agent unattended

A scheduled agent runs without preview, even if you have specified pre-
view on the Run Options tab of Properties.

When conflicts are encountered, they are ignored; neither file is copied. If ¥ For more infor-
you prefer to have the newer file in each conflict copied over the older one,  mation about re-
click Properties on the File menu. On the Run Options tab, click this option: ~ Solving conflicts,
Run Unattended, without Preview or Confirmations. Then click this option: ~ 5€€ P99¢ 104.
Copy the Newer File Over the Older.

% To ensure that an agent will run and synchronize as scheduled, create
an entry in Address Book. Include the log-in name and password
required by the remote computer to open the connection.



112 Chapter 5




Using Print Redirection

In this chapter

Using Print Redirection—Overview 114
Printing over a LapLink connection 116
Setting up printers for Print Redirection 118



Chapter 6

Using Print Redirection—Overview

There are two ways to print over a LapLink connection. While controlling a remote com-
puter, you can print from that computer directly to your local printer. Or you can reverse
direction and print directly from your local computer to a remote printer. Either way, you
use Print Redirection to send a document over LapLink to be printed at the opposite end
of the connection.

Go to illustration >  Once you have opened a LapLink connection, you can use Print Redirection
to send a document from the computer at either end of the connection to
a printer at the other end.

There are two ways to use Print Redirection over a LapLink connection:

O Print from remote to local While using Remote Control to view and
operate another computer, you can send a document from that com-
puter to a printer at your location. For example, you can prepare a doc-
ument on your office computer from home and print the document on
your home printer.

O Print from local to remote When connected to another LapLink
computer, you can print a document from your computer to a printer at
the remote location. For example, after working on a report at home or
on the road, you can connect to your office computer and print the
report to a high-quality laser printer in your office.

Without Print Redirection, you’d have to transfer the document to the
other computer and then use Remote Control to run a program on the
remote computer and print the document.

v For instructions Printing a document over a LapLink connection is much like printing it on a
on printing over a local printer: In the program in which you have prepared the document,
LapLink connec- choose the standard Print command. Normally you would then choose a

tion, see page 116. jrinter close at hand. In Print Redirection, however, you choose a printer
at the opposite end of the connection from the document.

When printing from remote to local, use Remote Control to choose Print on
the remote computer; then choose a printer attached to your local computer.

When printing from local to remote, choose Print on your local computer;
then choose a printer attached to the computer at the other end of the
LapLink connection.

Preparing for Print Redirection

v Tosetupa To print documents from a computer to a printer at the other end of a
printer for Print Re- L apLink connection, you need to set up the destination printer on that
Slargegtllolné see computer. If you want to print reports on the office printer while at home,

for example, set up the office printer on your home computer.



Using Print Redirection 115

Printing over a LapLink connection

Printing from While using Remote Control, you can prepare a
remote to local document on the remote computer and print it on
your local printer.

Printing from local You can prepare a document on your local com-
to remote puter, open a LapLink connection, and send the
document to a printer at the other end of the con-
nection.

You can set up a printer for Print Redirection during LapLink Setup or < Go to topic summary
afterward, using Print Redirection options in LapLink.

Requirements for Print Redirection

There are two requirements for using Print Redirection:

O You must connect to another version of LapLink that supports Print
Redirection.

O The default security setup on the other computer must be changed to
allow Print Redirection.
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Printing over a LapLink connection

To print over a LapLink connection, choose the standard Print command in any Win-
dows program and then choose a printer set up especially to receive print jobs from
remote computers. The document then travels over the LapLink connection, to a printer

at the other end.

Go to illustration >

v For information
about setting up a
printer for Print Re-
direction, see the
next section.

v You can use Print
Redirection over a
LapLink connection
even when it is not
one of the services
currently open.
Print Redirection be-
comes available on
demand.

Printing over a LapLink connection is much like printing to a local printer.
You simply choose a different printer—one that has been installed espe-
cially to print over LapLink.

When printing from remote to local, choose a local printer from the remote
computer using Remote Control. When printing from local to remote,
choose a remote printer from the local computer.

To print a document over a LapLink connection:
1 Open a LapLink connection to the remote computer.

¢ To print from remote to local, include Remote Control in the services
you open.

¢ To print from local to remote, open Print Redirection or any of the
other services.

2 Open a word processor, spreadsheet, or other program and prepare the
document for printing.

3 Use the standard Print command for your program and choose the
printer you set up just for Print Redirection. (It is typically a printer with
[LapLink] at the end of its name.)

The Print Redirection icon on the LapLink status bar animates as the docu-
ment is sent over a LapLink connection to the destination printer.

When the animation stops, the document has arrived at the other com-
puter. You can then close LapLink if you want.

-;- You can monitor the status of the printing document after it's been sent
over a LapLink connection. On the computer to which the printer is
attached, click the Windows Start menu, point to Control Panel, and
click Printers. Then double-click the printer icon.

Choosing among several printers

Normally, Print Redirection sends documents to the printer that has been
set up as the default printer on the connected computer. If you send a
print job from home to the office, for example, the printer designated as
the default on the office computer automatically gets the job. (If there is
only one printer set up on a computer, that printer is always used.)
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Printing over a LapLink connection
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The Print Redirection icon on the status bar

animates while the document is being sent to e
the other computer. The document is then @Eﬁ 153 54 o
printed.

If you want to use a printer other than the default, you need to set up < Go to topic summary
LapLink to prompt you with a list of available printers whenever you

print. Change this setting on the computer the printers are attached to,

not the computer with the document.

% If you're not in front of that computer, you can still change this setting
by remote controlling the computer.

To set up LapLink to prompt with a list of printers:

1 On the computer the printers are attached to, click Print Redirection
Options on the Options menu.

2 Click Prompt with a List of Available Printers.

Whenever you send a document to that computer to be printed, you'll be
prompted with a list of all the printers set up on that computer.
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Setting up printers for Print Redirection

To print documents from a computer to a printer at the other end of a LapLink connec-
tion, you need to set up the destination printer on that computer. If you do not set it up
while installing LapLink, you can set it up using the Print Redirection Options in LapLink.
For best results set up a printer identical to the one you will be printing to, at the other
end of the connection.

Go toillustration >  Before you can use Print Redirection, you need to add a printer for Print
Redirection to the computer you'll be printing from (the location where
your documents are kept).

v You may already For example, if you're remote controlling your office computer and want to
have added a print a document on that computer to your printer at home, you'll need to

printer when you in-  get up your home printer on the office computer.
stalled LapLink.

If you want to print a document on your home computer to a high-quality
printer at your office, you’'ll need to set up that printer on your home com-
puter.

The printer you set up for Print Redirection should match the printer you’ll
be printing to at the other end of the connection. Although it is possible to
use a compatible printer, the results you get when printing might not be as
good.

Setting up a printer

You can set up a printer during LapLink Setup or from within LapLink after
installation. You will probably need your Windows CD-ROM or the disk that
accompanied your printer.

To set up a printer from within LapLink:

1 Click Print Redirection Options on the Options menu.

2 Click the Setup button to start the Print Redirection Setup Wizard.
3 Follow the instructions in the wizard.

Once the printer is set up, you can print to it, and your document will be
sent over your LapLink connection. In order to print, LapLink must be run-
ning and connected to the computer you want to print to.
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Setting up a printer for Print Redirection
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Introduction to troubleshooting

This chapter provides checklists for solving problems and improving per-
formance. These checklists are designed as a quick overview of possible
solutions, with enough information to guide experienced users to solu-
tions.

For detailed, step-by-step information, consult the troubleshooters in
online Help. The troubleshooters are designed to solve problems you may
encounter in opening connections and using the services once you have
opened connections.

To use an online troubleshooter, open the Troubleshooting book in Help
Topics and display one of the topics. Then answer the questions about
your problem and try the suggested remedies. In some cases you will find
shortcut buttons to dialog boxes; use these buttons to resolve the problem
faster.

Using Help to troubleshoot a problem

Help Topics: Help for LapLink Professional

Contents | Index | Find |

To troubleshoot a prob-

Click a book, and then click Open. Or click another tak, such as Index. lem:
Glossary of terms :I Click HE|p Topics (HE|p
[2] LapLink Shortcut keys Menu).

@ Quick Steps for Laplink Professional

@ Online Reference for LapLink Professional
@ Cuick Steps for Xchange Agent

@ Online Refersnce for Xchange Agent

(Vi Troubleshooting

On the Contents tab,
double-click Trouble-

Introduction to Troubleshoaters
I'm hawving problems transferring files
I'm hawing problems printing

shooting.
Then double-click the
appropriate trouble-

I'm hawing problems chatting using Texdt Sl
I''m hawving problems connecting over cable
I'm hawing problems connecting owver CAPL 2.0/1SDMN

I'm hawving problems connecting over DialUp Networking
I'm hawing problems connecting over modem

I'm hawving problems connecting over network

I'rm hawing problems connecting over wireless

I'm hawing problems using Xchange Agent

o) ) 1] (0] [0 [0 1) ) [0 [-9] 9]

Dizplay I

Erint...

Click the problem you are
experiencing and try the
suggested solutions.

shooter.

E LapLink Troubleshooter
Back

Help Topics Dptions

Troubleshooting for Text Chat

This troubleshooter will help you identify and
solve problems with chatting with another
computer. Just click to answer the guestions,
and then try the suggested steps to fix the
problem.

What's wrong?

L Icant send a message to the other
computer.

— Ll | can't start Text Chat.

L | save my Text Chat session, but not all of it
is there.

L 1want ta send same infarmation fram
another application.




Troubleshooting Tips

Checklist for modem connections

|j Run LapLink on both computers

No connections are possible by modem or any other means unless
LapLink is running on both computers. You can connect to a computer
running LapLink Professional or another Windows-based version of
LapLink.

d In Windows 95 and Windows 98 use your Windows modem for
LapLink connections and enable its port

In Windows 95 and Windows 98 it’s a good idea to specify the modem
you've already set up in Windows as the modem to use in LapLink, too.
(In Windows NT, there is no alternative to using the Windows modem.)
In LaplLink, click Port Setup (Options menu), click Windows Modems, and
then check the Enable Port box.

If you have trouble communicating using the Windows modem, use Port
Setup to enable the COM port to which the modem is attached.

d Ensure that the modem can answer a call

A modem cannot answer an incoming call unless the Auto Answer option
is on. In Port Setup (Options menu), click Windows Modems. Click Con-
figure, and then verify that Enabled under Auto Answer is checked.

d Make sure the modem port is not already in use

LapLink cannot use a modem as long as the modem port is being used
by another program. Either close the program or wait until it releases the
port.

|j Check the settings for a Windows modem

If your modem does not answer calls or dial after you have enabled it as
a Windows modem in LapLink, exit LapLink, and make sure the modem
is turned on. In the Windows Control Panel, double-click Modems, click

the Diagnostics tab, and click the appropriate port. Click More Info. If the
test fails, click the General tab, and remove the modem. Shut down the
computer and then restart it. Return to Modems in the Control Panel and
reinstall the modem.

d Disable error control and data compression on both computers

Some modems communicate better if error control and data compression
are disabled on both computers. In Port Setup (Options menu), click Win-
dows Modems, Configure, and then Properties. On the Connection tab,
click Advanced. Then clear Use Error Control. Repeat this procedure on
the other computer.



v To let other com-
puters connect to
your computer by
modem, you must
change the security
setup established
during installation.

Chapter 7

[j Set a longer timeout value

If the computer you are dialing takes a long time to answer and complete
the connection, try increasing its modem timeout. In Port Setup (Options
menu), click Windows Modems. Click Configure and then Properties. On
the Connection tab, type a larger number in this box: Cancel the Call If
Not Connected Within.

d Lower the modem speed on the computer opening the connec-
tion
In Port Setup (Options menu), click Windows Modems. Click Configure
and then Properties. On the General tab, click a lower speed in the Max-
imum Speed box.

[j Check the security setup on the remote computer

If you are denied the use of Remote Control or one of the other services
while connected to another computer, check the security setup on that
computer. You can gain access to services through Security (Options
menu).

d Disable call waiting

Ensure that the call waiting feature is disabled on the telephone systems
at both ends of the connection. Call waiting interferes with modem con-
nections when incoming calls are detected.

d Try using Dialing Properties to simplify the dialing process
When you use a Windows modem, try using the Dialing Properties feature
in connection with Address Book. It simplifies the process of accessing
outside lines, making long-distance and international calls, and using a
calling card.

With the proliferation of area codes, however, you may find that some
numbers may not be dialed correctly, as when you make a local call to
another area code or a long-distance call within the same area code. In
this case, edit your Address Book entry for that number so that the Use
Country Code and Area Code box is cleared. In the Telephone Number
box, type the number exactly as it is to be dialed. Include the number for
outside access, country code, area code, and “1” for long-distance, as re-
quired. (When you travel, you may have to edit this data to reflect your
current location.)

[j Disable other programs that use COM ports while running
LapLink

You may experience problems if you use LapLink to connect by modem
while running any other programs that monitor serial (COM) ports; mo-
dem and fax programs typically monitor serial ports for incoming calls or
faxes and may cause a modem to disconnect unexpectedly. Disable such
programs while using LapLink.
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Checklist for Dial-Up Networking connections

|j Ensure that Dial-Up Networking is installed

You can connect over Dial-Up Networking only if Microsoft Dial-Up Net-
working has been installed. Dial-Up Networking should already be in-
stalled in Windows NT. In Windows 95 or Windows 98, you can install this
feature from your Windows CD-ROM as follows: In the Windows Control
Panel, double-click Add/Remove Programs. Click the Windows Setup tab,
and double-click the Communications line. If Dial-Up Networking is
checked, it is installed. If it is not checked, click Dial-Up Networking, and
then click OK to begin installation.

|j Once connected using Dial-Up Networking, connect to the net-
work

When you connect over Dial-Up Networking in LapLink, you dial in to a
remote access server and connect to a network. Then you make LapLink
connections in the Connect over Network dialog box. Unless you specify
otherwise, the list of available LapLink connections appears automatically
as soon as you are connected to the network. If the list of connections
does not appear automatically, click the Connect button on the LinkBar
and then click Network.

’ To connect to another LapLink computer as soon as a Dial-Up Net-
working connection is established, make sure that this box is checked in
the Connect over Dial-Up Networking dialog box: After Connecting to the
Network, Choose a Laplink Connection.

d Ensure that your computer is set up for network connections

Making connections to other LapLink computers through Dial-Up Net-
working requires that your computer meet the requirements for network
connections in LapLink: a network protocol must be installed, your net-
work ports must be enabled in LapLink, and so on. For more information
about network connections, see page 127.

|j Run LapLink on both computers

No connections are possible by Dial-Up Networking or any other means
unless LapLink is running on both computers. You can connect to a com-
puter running LapLink Professional or another Windows-based version of
LapLink. Verify that the computer has a network port enabled for the
same kind of network connection as your network port.

d Try using Dialing Properties to simplify the dialing process
When you use a Windows modem, try using the Dialing Properties feature
in connection with Address Book. It simplifies the process of accessing
outside lines, making long-distance and international calls, and using a
calling card.

v’ For more infor-
mation about Mi-
crosoft Dial-Up
Networking, con-
sult Windows Help.

v To let other com-
puters connect to
your computer
through Dial-Up
Networking, you
must change the
security setup es-
tablished during in-
stallation.
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With the proliferation of area codes, however, you may find that some
numbers may not be dialed correctly, as when you make a local call to
another area code or a long-distance call within the same area code. In
this case, edit your Address Book entry for that number so that the Use
Country Code and Area Code box is cleared. In the Telephone Number
box, type the number exactly as it is to be dialed. Include the number for
outside access, country code, area code, and “1” for long-distance, as re-
quired. (When you travel, you may have to edit this data to reflect your
current location.)

|j Disable other programs that use serial (COM) ports while running
LapLink
You may experience problems if you use LapLink to connect by modem
while running any other programs that monitor serial (COM) ports; mo-
dem and fax programs typically monitor serial ports for incoming calls or
faxes and may cause a modem to disconnect unexpectedly. Disable such
programs while using LapLink.

|j Disconnect a Dial-Up Networking connection

When connecting by modem, you can instruct LapLink to break a connec-
tion after a specified number of minutes in which there is no activity at
either end of the connection: Click Connect Options (Options menu). On
the Disconnect tab, check the Disconnect Inactive Connections box, and
type the number of minutes below.

In most cases, the connection is completely broken after the specified pe-
riod. With Dial-Up Networking connections, however, you must complete
the process: click Disconnect (Connect menu) and then click Disconnect
All.
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Checklist for network connections

|j Enable the network port for LapLink

Access to a network by e-mail and other programs does not automatically
provide network access in LapLink. To connect by network in LapLink,
your network port must be enabled—that is, made available for use in
LapLink. To enable a network port in LapLink, click Port Setup (Options
menu). Click the type of network—either IPX or TCP/IP—in the Ports list.
Then check the Enable Port box. If the network is IPX, click Configure,
and ensure that Internetwork Name Broadcast is checked.

d Run LapLink on both computers

No connections are possible by network or any other means unless
LapLink is running on both computers. You can connect to a computer
running LapLink Professional or another Windows-based version of
LapLink. (LapLink for Windows 3.1 allows connections over IPX networks
but not over TCP/IP networks.) Verify that the computer has a network
port enabled for the same kind of network connection as your network
port.

d Refresh the list of connections

If LapLink was started on the other computer after you started connect-
ing, you may need to refresh the list of available connections in order to
include the computer in the list. Click the Refresh List button, and wait
while the list of LapLink computers is updated.

|j Ensure that the network is installed

LapLink cannot connect by network unless a network protocol—either IPX
or TCP/IP—is installed. Network protocols are installed using the Net-
works option in the Windows Control Panel. See your Windows Help and
documentation for information on adding network protocols.

d Type the TCP/IP name or address

If you do not see a computer listed as an available connection over a
TCP/IP network, you may have to type the computer’s IP nhame or ad-
dress. Click the Connect button on the LinkBar, and then click Network.
On the TCP/IP Addresses tab, type the IP address or the Windows com-
puter name in the TCP/IP Name or Address box. (This name may differ
from the name assigned to the computer in LapLink.)

’ To determine the TCP/IP address for a Windows 95 or Windows 98
computer, click Port Setup (Options menu); click TCP/IP in the ports list;
and then click Configure. The computer’s address appears in the IP
Address box.

’ To determine the TCP/IP address for a Windows NT computer, click
the Start button, point to Programs, and click Command Prompt. Then
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type IPCONFIG and press ENTER. The address appears on the IP Address
line.

' If you cannot connect after typing a TCP/IP address, click the Start
button, point to Programs, and click MS-DOS Prompt. Then type PING
followed by a space and the address you are trying to reach. Press
ENTER. If you do not receive a positive reply, the address is not avail-
able, and you cannot connect.

|j Check the security setup of the remote computer

v To let other com- If you are denied the use of Remote Control or one of the other services
puters connect to a while connected to another computer, check the security setup on that
computer by net- computer. You can gain access to services through Security (Options

work, you must
change the security
setup established
during installation.

menu).

|j IPX connections: change the type of frame on both computers

Some IPX connections work better if the frame type for the IPX connec-
tion is preset rather than selected automatically; try setting the frame
type to Ethernet 802.2 or Ethernet 802.3. This setting should be changed
on both computers making a LapLink connection. Network protocols are
installed using the Networks option in the Windows Control Panel. See
your Windows Help and documentation for information on changing the
frame type.
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Checklist for cable connections

|j Ensure that Autoconnect is turned on

Autoconnect opens cable connections for you automatically. To ensure
that Autoconnect is in effect, click Connect Options (Options menu). On
the Connect tab, verify that this box is checked: Enable Autoconnect. Be-
low the option, verify that the services you want to use are also checked.

' If you have trouble maintaining a cable connection, try disabling
Autoconnect on one or both of the computers.

d Run LapLink on both computers

No connections are possible by cable or any other means unless LapLink
is running on both computers. You can connect to a computer running
LapLink Professional or another Windows-based version of LapLink.

d Check the cable
Make sure that each end of the cable is securely attached to the proper
port; check the port labels for proper identification. Check a parallel cable
for damaged pins. Try reconnecting the cable to each port or even revers-
ing the cable ends.

' Attach the yellow LapLink cable to Parallel/LPT (printer) ports. Attach
the blue LapLink cable to Serial/COM (modem or mouse) ports; connect
only one end to each computer. LapLink does not work over most other
serial cables or any printer cables. Attach a LapLink USB cable to a USB
port or a USB hub at each computer.

d Consult the Windows Device Manager when in doubt about USB
or other kinds of ports

If you are not certain whether you have a USB port or another kind of

port, check the Windows Device Manager: Right-click My Computer; then
click Properties. Look on the Device Manager tab. Note that USB connec-
tions are not available in Windows NT or in early versions of Windows 95.

|j Enable the port
You cannot connect by cable until a port is enabled—that is, made avail-
able specifically to LapLink. To enable a port for cable, click Port Setup
(Options menu). Click the port you want to enable. Then check the Enable
Port box.

' If a port is listed as unavailable, quit any program that may be using
the port, or enable a different port. Make sure that the cable is attached
to an available port.



v Parallel cable
connections are not
available in Win-
dows NT; use a se-
rial cable instead.

v For maximum
performance from
an ECP port, use the
Windows driver for
the parallel port to
which the cable is
attached.
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[j Use a serial cable when connecting to a Windows NT computer

When you want to connect by cable to a computer running LapLink on
Windows NT, parallel and USB connections are not available. Use a serial
cable instead.

[j Serial cable connections: lower the speed of a serial port

In Port Setup (Options menu), click the COM port to which the cable is
attached. Click Configure. In the Port Speed box, click 57600. Repeat this
procedure on the other computer. If you still can’t connect, repeat the
procedure, lowering the speed one step at a time until you can connect.

[j Serial cable connections: check for an internal modem

In Port Setup (Options menu), look for an internal modem that is enabled
for the serial port to which the cable is attached. Change the port setup
so that the modem is enabled for a different serial port.

[j Restart the computer

If all else fails, remove the cable from both computers, and restart the
computers. Reattach the cable, and try the connection again.

d Improving parallel cable performance in Windows 95 and
Windows 98

There are three drivers you can use in LapLink for parallel ports: the
LapLink Enhanced driver (the default), the LapLink Standard driver, and
a Windows driver. The LapLink Enhanced driver is preferable when you
alternate between parallel communications and other types of communi-
cations: you can leave the parallel port enabled without experiencing any
degradation of performance. The Windows driver, on the other hand,
generally provides better performance for parallel connections; use the
Windows driver if you intend to use parallel connections exclusively. If
you then want to switch to modem or some other type of communication,
be sure to disable the parallel port beforehand.

To change the parallel port driver, click Port Setup (Options menu) and
then click the appropriate LPT port. Ensure that the Enable Port box is
checked. Click Configure and then click one of these options: Use the
Windows Driver, Use the LapLink Enhanced Driver, or Use the LapLink
Standard Driver.
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Checklist for wireless connections

d Make sure you‘re not trying to connect to a Windows NT computer

You cannot connect computers using wireless devices when either or both
of the computers is running Windows NT. Use a serial cable instead.

d Set up the Windows infrared driver

The Windows infrared driver supports a variety of built-in ports and de-
vices attached to serial ports. When you set up the driver, specify any se-
rial port, from COM1 to COM9, as the redirected port. In LapLink Port
Setup (Options menu), enable the redirected port for wireless communi-
cations.

|j Edit the LapLink initialization file if you use AirShare Radio Mod-
ules

A setting in the LLW.INI file must be changed in order to connect com-
puters using AirShare Radio Modules. Open LLW.INI in Notepad; the file
is located in the \TSI32\LLW subfolder within your Windows folder. Lo-
cate the section of the file corresponding to your wireless port: [COM1],
[COM2], and so on. Edit the section so that it includes this line:
UselRDADriver=No. Restart LapLink. In Port Setup (Options menu), ensure
that the port is enabled for wireless communications.

d Enable the wireless port

You cannot connect by wireless until a serial port is enabled for wireless
connections in LapLink. In Port Setup (Options menu), click the COM port
to which the wireless device is attached. Click Wireless in the Type box,
and then check the Enable Port box.

|j Ensure that Autoconnect is turned on

Autoconnect opens wireless connections for you automatically. To ensure
that Autoconnect is in effect, click Connect Options (Options menu), and
verify that this box is checked: Enable Autoconnect. Below the option,
verify that the services you want to use are also checked.

|j Run LapLink on both computers

No connections are possible by wireless or any other means unless
LapLink is running on both computers. You can connect to a computer
running LapLink Professional or another Windows-based version of
LapLink.

d Check the cable, if any

If you have an external wireless device, make sure that its cable is se-
curely attached to the proper port.

v In LapLink, wire-
less refers to short-
range connections
over infrared or ra-
dio devices. Other
“wireless” connec-
tions are available
over wireless LAN
adapters (using
Connect over Net-
work) and cellular
modems (using
Connect over Mo-
dem).
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|j Lower the speed of the ports

If you are using wireless devices without the Windows infrared driver, try
lowering the port speeds on both computers. In Port Setup (Options
menu), click the COM port to which the wireless device is attached. Click
Configure, and then click 57600 in the Port Speed box. Repeat this pro-
cedure on the other computer. If you still can’t connect, repeat the pro-
cedure, lowering the speed one step at a time until you can.

|j Tips for AirShare Radio Modules
' Check the LED lights; both the red and the green lights should be lit.

’ On one computer at a time, try connecting the module to a different
serial (COM) port.

’ Switch to a different channel; be sure that the same channel is set on
both modules.

’ Move the modules closer together and away from metal surfaces, lap-
top screens, desktop monitors, and electrical transformers.

’ Swap the modules between the computers.

' Replace the batteries.
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Checklist for CAPI 2.0/ISDN

|j Run CAPI-compatible versions of LapLink on both computers

No connections are possible by CAPI 2.0/ISDN or any other means unless
LapLink is running on both computers. Ensure that the version of LapLink
running on that computer is compatible with CAPI 2.0/ISDN.

|j Check the security setup on the remote computer

If you are denied the use of Remote Control or one of the other services
while connected to another computer, check the security setup on that
computer. You can gain access to services through Security (Options
menu).

d Ensure that LapLink is set up to answer calls over CAPI 2.0/ISDN

CAPI cannot answer an incoming call unless the Auto Answer option in
LapLink is enabled. In Port Setup (Options menu), click CAPI 2.0/ISDN.
Click Configure, and then verify that the Enable box under Auto Answer
is checked.

|j If you are using ISDN in North America, avoid using the LapLink
CAPI 2.0/ISDN

In North America, ISDN doesn‘t usually include CAPI 2.0 but you can still
use your ISDN device in LapLink. If the device is set up as a Windows
(TAPI) modem, you can open a LapLink connection using Connect over
Modem or Connect over Dial-Up Networking. Simply ensure that the de-
vice is enabled in LapLink Port Setup (Options menu) as a Windows mo-
dem.

If your ISDN device is set with its own dialer, use the dialer to log on to
a network. Then, in LapLink, use Connect over Network to connect to oth-
er computers running LapLink on that network.

d Close some LapLink services to allow connections over both
channels

Normally CAPI 2.0/ISDN hosts on which channel bonding is not enabled
can handle incoming connections on both channels. When only one con-
nection is possible, try closing services on that connection.
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Checklist for File Transfer

v To ensure that
files are copied,
press CTRL while
dragging. To en-
sure that files are
moved, press SHIFT
while dragging.

v To set up LapLink
to run before the
Windows logon dia-
log box appears,
click Remote Con-
trol Options (Op-
tions menu). On the
Startup tab, check
this box: Always
Start LapLink before
Windows Logon
Prompt.

[j Drop files directly on target folder

The most common mistake in drag and drop is dropping files on the
wrong target folder (the folder to receive the files). To help prevent this
mistake, open the target folder first; the name of the folder now appears
in the title bar. Then open the source folder and select and drag the files
until the mouse pointer rests on the open folder and the folder is high-
lighted. As soon as you release the mouse button, you receive a confir-
mation dialog box showing, among other things, the target you just
dropped on. Check the target, and change it if necessary.

' If you are copying an entire folder (rather than files within a folder),
drop the folder on the target one level higher than where you want the
files to appear; this may be another folder or a drive letter. Assume that
you want to update your Letters folder on your desktop computer with
your Letters folder from your laptop, and the Letters folder appears at
the highest level of folders on drive C. Drag the folder from the laptop to
the desktop and drop it on drive letter C.

[j Use the Copy or Move command

Instead of using drag and drop, use the Copy or Move command. First,
click the target folder. After selecting the files to be transferred, click Copy
or Move (File menu). Then verify that the source and target are correct.

[j Make File Transfer available to other computers

If you are denied the use of File Transfer or one of the other services while
connected to another computer, check the security setup on that com-
puter. You can gain access to services through Security (Options menu).

[j Log on to Windows before trying to use File Transfer

As a security measure, LapLink does not allow users to connect to a com-
puter and open File Transfer while the computer is waiting to be logged
on to Windows. (When you attempt to open a File Transfer connection to
a computer running LapLink and displaying the Windows logon dialog,
you see this message: “Creation of window failed.”)

The solution is to open a Remote Control connection first. Log the remote
computer on to Windows and then open File Transfer.

[j General tips for faster transfers
Follow these suggestions to improve transfer speeds:

’ Check the folders and files you have selected for transfer, making
sure that you are not including more than necessary. For example, have
you selected an entire folder when you want to transfer only a few files
within the folder?
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' Use SpeedSync to improve file transfer times when updating files,
particularly over modems: on the Performance tab of File Transfer
Options, make sure that the Use SpeedSync on All File Transfers box is
checked.

’ Disable any ports that are not in use: in Port Setup (Options menu),
click an unused port, and then clear the Enable Port box.

’ Close other service windows and any connections to other computers
you may have opened in LapLink.

’ On laptop computers, disable power management functions. Attach
the AC adapter to the computer to ensure steady voltage throughout the
transfer.

' Disable screen savers, and close other programs.

|j Tips for transfers over a serial cable

’ Ensure that the serial port is configured for maximum speed: in Port
Setup (Options menu), click the appropriate COM port; click Configure;
and ensure that Port Speed is set at 115200.

’ Change the transfer mode to standard: in Port Setup (Options menu),
click the appropriate COM port; click Configure; and click Standard
under Transfer Mode.

d Tips for transfers over modems

Consult the documentation for your modem and verify that the port
speed is set for optimum performance: In Port Setup (Options menu),
click Windows Modems. Click Configure, and click the modem you are us-
ing. Click Properties. In the Maximum Speed list on the General tab, click
the maximum speed your modem can use.

|j Tips for transfers over a network
' Transfer your files when there is less traffic on the network.

’ Ask your system administrator to verify that the network drivers are
current.

|j Tips for SmartXchange

Use SmartXchange to update files in two folders so that the folders share
the latest files. Since SmartXchange always overwrites older files, do not
use it if you want to merge the contents of two files. Use SmartXchange
by opening the two folders you want to update; do not select the individ-
ual files. After clicking SmartXchange (SyncTools menu), verify that you
have opened the right folders. If you do not want to add new files to either
folder, check this box: Transfer Only If Files Are Already on Target.

' Because long file names are not supported in Windows 3.1,
SmartXchange may not work as expected when you are synchronizing
with a computer running LapLink for Windows 3.1. For more informa-
tion, see page 95.
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|j Ensure that you have read access rights to network files you
want to copy

If you can locate the files you want to copy but then are denied access
when you attempt to copy them, contact the network administrator. You
can copy only files to which you have been assigned read access.
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Checklist for Xchange Agent

[j Ensure that LapLink is running on the remote computer v Because long file

LapLink must be running on the remote computer before an agent can n?)m:; ;rsv?r?éos\t’vz'

connect to it and synchronize files. On the local computer merely keep 5.1, Xchange Agent
Windows running. (LapLink will start automatically when the agent runs.) may not work as

expected when you

d Make sure that a scheduler program is running attempt to synchro-
To schedule Xchange Agents—and have them run on schedule—you nize with a com-

must have a supported scheduler program running. E:;t)ﬂnrll(”f]gr":/?/in-

LapLink prepares an Xchange Agent to run on either of these scheduler ~ dows 3.1. For more
programs: the System Agent program included in the Microsoft Plus! mfornl%téon, see
Companion for Windows 95; and the Task Scheduler program included page '

in Microsoft Internet Explorer (not supported in Windows NT 4.0). If you

don’t have either of these programs, LapLink uses its own scheduler

program, which it installs during Setup. (Its icon appears at the right end

of the Windows taskbar.)

d You can disable LapLink Scheduler if you do not intend to use it

If you do not intend to use LapLink Scheduler to run Xchange Agents, you ¢ When LapLink

can keep it from starting automatically every time you start Windows. Scheduler is run-
ning, its icon ap-

To disable LapLink Scheduler, right-click the Windows Start button and pears on the

click Open (in Windows NT, click Open All Users). Double-click Programs ~ Windows taskbar.

and then Startup. Click Scheduler and press DELETE.

|j Close an Xchange Agent before it is scheduled to run
An agent cannot run on schedule while it remains open in Xchange Agent.

d Create an Address Book entry to meet the security requirements
of the remote computer

If the remote computer requires a name and password, create an Ad-
dress Book entry and include the name and password required by that
computer. LapLink can then send this information and connect automat-
ically.

|j Turn off the LapLink callback feature

If the remote computer requires or requests a callback before opening a
modem connection, the agent cannot run. On the remote computer, turn
off the callback feature: Click the Security button on the LinkBar. On the
Log-in List tab, click the name of the guest computer and then click Edit.
Under Modem Callback, click None.

d Avoid moving or deleting agent files for which you have created
shortcut icons

If you have moved or deleted the Xchange Agent file, the shortcut icon
can no longer run the agent. Create the agent again. You can reuse the
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shortcut icon by saving the new file in the same location, with the same
name, as the original file. Or you can create a shortcut icon for the new
agent file.

|j Create a filter to synchronize a single file

Xchange Agent always synchronizes by folder pairs, but you can create a
filter so that only one file within a folder pair is synchronized. Open the
agent in Xchange Agent and click the folder pair. On the Edit menu, click
Set Filter and then click New. After typing a description for the filter, type
the complete name of the file, including its extension. (To add more than
one file name, type a semicolon and then the next file name.) Click OK.
Click the filter's name in the Available Filters list, and then click Add.

’ Preview the agent to see if the correct files are included in the syn-
chronization.

|j Use Preview to limit the files to be copied in the current synchro-
nization

While previewing an agent, you can specify that certain pairs of files and
folders will be omitted from the current synchronization: Click a pair of
files or folders and then click the Skip Pair button on the toolbar. Repeat
this procedure for any other pairs you do not want synchronized. Then—
before closing Preview or quitting Xchange Agent—run the agent.

’ You can omit file and folder pairs only from the current synchroniza-
tion. To remove them from a future synchronization, you must use Pre-
view again.

|j Use Xchange Agent to overwrite, not merge, files

Xchange Agent overwrites files. Unless you specify otherwise, it copies
the newer file to the other computer. It does not merge files. To merge
databases and other shared files, use the program in which the files were
created.
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Checklist for Remote Control

|j Improve performance from the guest

On the guest, you may be able to speed up Remote Control connections
by changing settings in Remote Control Options (Options menu) on your
computer. On the Performance tab, click the Best Performance option.
(To further customize settings, click the Settings button.) Your view of the
host should be updated faster, though you will now be viewing the host
screen in black and white, and larger bitmaps will not be displayed.

|j Control the display properties of the host from the guest

By default, LapLink is configured to speed up Remote Control connec-
tions: any wallpaper or screen saver on the host is temporarily disabled,
along with certain other visual enhancements. From the guest, you can
restore these enhancements to the host screen through settings on your
computer. On the Performance tab of Remote Control Options (Options
menu), click Best Quality. (To further customize settings, click the Set-
tings button.) Keep in mind that changing these settings may slow Re-
mote Control connections.

d Make Remote Control available to other computers

If you are denied the use of Remote Control or one of the other services
while connected to another computer, check the security setup on that
computer. You can gain access to services through Security (Options
menu).

|j Use the keyboard to view the host screen

If the window in which you are viewing the host screen does not show all
of the host screen, you can use your keyboard to view areas beyond the
borders of the window: press CTRL+ALT+SHIFT and any of the arrow
keys, PAGE UP, PAGE DOWN, HOME, or END.

d Use the latest driver for your video adapter

Contact the manufacturer of your video adapter, on its Web site or else-
where, to verify that you are using the latest driver.

|j Avoid changing the color depth or display properties of a host

From the guest, avoid changing the number of colors displayed on the
host while you're connected to it using Remote Control. Also avoid chang-
ing the Refresh Frequency and other settings in the host's Display Prop-
erties while connected. To safely change these properties, you should be
seated at the host and fully informed of the capabilities of its monitor. In-
correct settings can damage a monitor.

|j Use a special key combination to log on to a Windows NT host

When you restart a Windows NT host, you must press CTRL+ALT+DELETE
to log on to Windows again. You can accomplish this from the guest by
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v To have
CTRL+ALT+DELETE
take effect on a host
computer, click Send
CTRL+ALT+DELETE
to Host on the
guest's Session
menu.
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pressing a special key combination specified on the host. (Pressing
CTRL+ALT+DELETE on the guest affects the guest, not the host.) To spec-
ify a key combination for use on the guest, start LapLink on the host and
click Remote Control Options (Options menu). On the Host tab, type the
key combination in this box: Send CTRL+ALT+DELETE to This Computer
When a Guest Presses This Key Combination.

' Instead of pressing a special key combination for CTRL+ALT+DELETE,
you can click the Remote Control icon at the bottom of the host’s LapLink
workplace, and then click Feed CTRL+ALT+DELETE.

[j Do not install other remote control products and LapLink on the

same computer

Because of possible incompatibilities, avoid installing LapLink and another
remote control product on the same computer.

[j Avoid pressing CTRL+ALT+DELETE when viewing a Windows NT

host in full-screen Remote Control

Pressing CTRL+ALT+DELETE on a Windows NT computer always displays
the Windows Security dialog box on that computer. When you are work-
ing in a full-screen Remote Control session, pressing CTRL+ALT+DELETE
not only displays the Security dialog box locally but also causes the CTRL
and ALT keys to be pressed—but not released—on the host computer. To
release these keys and resume normal keyboard operation press CTRL
and ALT again.

[j Keep LapLink running before the Windows NT logon prompt

If you have set up LapLink on the host computer to run before the Win-
dows NT logon dialog box appears, avoid closing LapLink on that comput-
er unless you have Administrator rights. If you close LapLink, you will
have to restart the computer in order to reset LapLink so that other peo-
ple can connect. (Restarting LapLink is not sufficient.)

j Avoid running a Windows NT host in VGA mode

When a Windows NT computer is running in VGA mode you can make
LapLink connections from it to other computers using Remote Control and
File Transfer, but the computer cannot serve as a Remote Control host.
That is, it cannot be remotely controlled by other computers.

[j Run DOS in a window on a Windows NT host

You cannot control full-screen DOS programs on a Windows NT host.
When you attempt to do so, LapLink minimizes the program and displays
a warning message. (To close the DOS program, right-click the icon, and
click Close.)

Avoid this problem by setting up the Windows NT host to display DOS
programs in a window. If you use a shortcut to a DOS program, for ex-
ample, right-click the shortcut icon, click Properties, and then click the
Options tab. Below Display Options, check Window.
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Checklist for Print Redirection

|j Use the same printer driver on both ends of a connection

For best print results in Print Redirection, both computers should be set
up with the same printer driver. To add a printer driver, you may need
your Windows CD or a disk from the printer manufacturer.

|j Use the Windows Control Panel to get additional information

If the document you printed is sent over LapLink correctly but does not
print, examine the printer in the Windows Control Panel to get additional
information about why the document didn't print. Make sure the printer
is connected correctly and has enough paper, and the printer cartridge is
not empty.

[j When several printers are available, you can set up LapLink to
prompt you for the printer to use

Normally, LapLink automatically directs print jobs to the printer currently
set up as the default printer at the other end of the connection. When
there are several printers available, however, you may want to use a
printer other than the default.

To set up LapLink to allow you to choose among the available printers,
click Print Redirection Options (Options menu) on the computer the print-
ers are attached to. Then click Prompt with a List of Available Printers.

d When printing from 16-bit programs, use the default printer

Before printing from 16-bit Windows programs (programs written for ver-
sions of Windows prior to Windows 95, Windows 98, and Windows NT
4.0), set up the destination printer as the default printer on the computer
to which it is attached. When using Print Redirection from the 16-bit Win-
dows program, print to the default printer instead of selecting a printer
from the list of available ones.

d Some printer drivers do not support Print Redirection

To use Print Redirection you must set up a printer to direct print jobs to
a special port instead of the usual parallel port. You cannot use a printer
driver that does not allow you to change the port in this way. You may
want to contact the printer manufacturer to see if an updated driver is
available.
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Checklist for Text Chat

|j Press ENTER to send your message

Type your message in the lower part of the Text Chat window. (In some
cases, you may have to click in the lower part of the window before you
can begin typing.) To send your message to the remote computer, press
ENTER.

' To begin a new paragraph, press CTRL+ENTER.

|j Open a Text Chat window after connecting

If you are connected to more than one computer, be sure to specify which
computer you want to use Text Chat with: Click the name of the comput-
er on the Window menu. Then click the Open Text Chat button on the
LinkBar or Open Text Chat on the Window menu.

|j Make Text Chat available to other computers

If you are denied the use of Text Chat or one of the other services while
connected to another computer, check the security setup on that com-
puter. You can gain access to services through Security (Options menu).

|j Save your Text Chat conversation from time to time

As a Text Chat conversation grows in length, the most recent messages
begin to replace the earliest. This starts to happen when the conversation
exceeds 32,000 characters. If you intend to save a lengthy conversation,
begin saving before this limit is reached. To save a conversation, click in
the upper part of the Text Chat window. Click Select All (Edit menu), and
then click Copy (Edit menu). You can then switch to another Windows
program such as Notepad, paste the text, and save it as a file.

|j Shorten connection time by preparing messages beforehand

Instead of typing text while connected, you can prepare it ahead of time
in Notepad or a similar Windows program and send it to a remote com-
puter through Text Chat. In the other application, select the text, and
press CTRL+C to copy. In the lower part of the Text Chat window, press
CTRL+V to paste. Then press ENTER to send.

|j Use File Transfer for long messages

Text Chat can send as many as 2,048 characters at once. When you at-
tempt to send a message that exceeds that limit, part of the message will
not be transmitted to the other computer. Try sending the message in
parts. Or save the message as a file, and send the file using File Transfer.
You can still use the Text Chat window to let the remote user know what
you're sending and to pass along additional notes.
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Traveling Software License Agreement

Traveling Software License Agreement

IF YOU BREAK THE SEAL OR OTHERWISE OPEN THE PACKAGE CONTAINING THE SOFTWARE PROGRAM
MEDIA, YOU ARE BY THAT ACT AGREEING TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS
LICENSE AGREEMENT.

Ownership of Software. You acknowledge and agree that all of the computer programs and associated
documentation contained in this package (collectively, the “Software”) are owned exclusively by Travel-
ing Software and/or its licensors. The Software is protected under copyright and other intellectual prop-
erty laws of the United States and international copyright treaties. You acknowledge and agree that the
price paid by you for the Software is a license fee granting you only the rights set forth in this License
Agreement.

License. Traveling Software grants to you, and you accept, a limited, non-exclusive and revocable license
to use the Software, in machine-readable, object code form only. You agree to use the Software only as
authorized in this License Agreement. This License Agreement does not convey to you any ownership
rights or any other interest in the Software.

Scope of License. This is a single-user, multiple computer license, which means you are authorized to
use the Software on up to a total of three personal computers that are used exclusively by you (e.g.,
office, portable and home). A valid license must be purchased for each person who will use the Software.
You may only use the Software to link with a computer not used solely by you if the user of that computer
has a valid license.

If this software is to be installed on a network server, or more than one user can run the Software, you must
purchase an additional license for each user or computer workstation. Please contact the location where your
purchased the Software and this license, or contact Traveling Software, to obtain additional licenses.

You may not copy or make any changes or modifications to the Software, and you may not translate, de-
compile, disassemble, or otherwise reverse engineer the computer program(s). You may not loan, rent,
lease or sublicense the Software or any copy to others for any purpose. You agree to use all reasonable
efforts to protect the Software from unauthorized use, modification, reproduction, distribution or publica-
tion. You are not permitted to make any uses or copies of the Software that are not specifically authorized
by the terms of this License Agreement, and Traveling Software reserves all rights that are not expressly
granted to you. Your adherence to this License Agreement will allow Traveling Software to continue devel-
oping innovative and useful products and providing a high level of customer service and support.

Term. This license will become effective on the date you acquire the Software and will remain in force

until terminated. You may terminate this license at any time by removing the Software from your com-
puter and destroying the original Software and all copies. This license will automatically terminate if you
breach any of the terms or conditions set out in this License Agreement. You agree to remove the Soft-
ware from your computer, and either to destroy the original Software and all copies of the Software and
documentation or to return them to Traveling Software, upon termination of this license for any reason.

Transfer. You may transfer your license of the Software to another party by transferring the original pro-
gram media and all applicable documentation, including the original of this License Agreement, to the
recipient, who agrees to the terms of this Agreement. All other copies of the Software must be deleted
and/or destroyed. Any transfer of possession of the Software terminates your license and all associated
benefits under this License Agreement. You must notify Traveling Software in writing of such a transfer.

Archival Copy. You may make one copy of this Software and associated documentation solely for backup
or archival purposes. Alternatively, you may transfer this Software to a single hard disk drive, provided
that you keep the original program media and accompanying documentation in your possession for back-
up or archival purposes. Any such copies of the Software or documentation shall include Traveling Soft-
ware’s copyright and other ownership notices. No other copies of Software or documentation may be
made by you or any person under your authority or control.
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Limited Warranty. Traveling Software warrants the physical program media, cable(s) and physical docu-
mentation to be free from defects in materials and workmanship for a period of 90 days from the date of
your purchase. If you notify Traveling Software of defects in materials or workmanship during the warranty
period, Traveling Software will replace the defective program media or documentation or, at its option, re-
fund the purchase price. Your remedy for breach of this warranty shall be limited to replacement or refund
and shall not encompass any other damages. No dealer, distributor, agent or employee of Traveling Soft-
ware is authorized to make any modification or addition to the warranty and remedies stated above.

TRAVELING SOFTWARE SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. TRAVELING SOFTWARE DOES NOT WARRANT THE PHYSICAL PROGRAM MEDIA,
CABLE, PHYSICAL DOCUMENTATION OR COMPUTER PROGRAM(S) OTHER THAN AS EXPRESSLY STATED
ABOVE, NOR DOES TRAVELING SOFTWARE PROVIDE ANY WARRANTY AS TO THE OPERATION OF THE
SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR APPLICATION, USE, OR PURPOSE.

Limitations of Liability and Remedies. IN NO EVENT SHALL TRAVELING SOFTWARE OR ITS LICENSORS
BE LIABLE FOR ANY LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGE, INCLUDING BUT NOT LIM-
ITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR OTHER DAMAGES, EVEN IF TRAVEL-
ING SOFTWARE OR ITS LICENSORS ARE ADVISED, IN ADVANCE, OF THE POSSIBILITY OF SUCH
DAMAGES. IN NO EVENT SHALL THE LIABILITY OF TRAVELING SOFTWARE OR ITS LICENSORS EXCEED
THE PURCHASE PRICE PAID FOR THE SOFTWARE, LESS ALL APPLICABLE TAXES AND DUTIES. SOME
STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR INCIDENTAL OR CONSE-
QUENTIAL DAMAGES, SO THE AFOREMENTIONED LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

U.S. Government Restricted Rights. The Software is provided with Restricted Rights. Use, duplication,
or disclosure by the United States Government is subject to restrictions set forth in subparagraph
(€)(1)(ii) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or sub-
paragraphs (c)(1) and (2) of the Commercial Computer Software—Restricted Rights at 48 CFR 52.227-
19, as applicable. Contractor/Manufacturer is Traveling Software, Inc., 18702 North Creek Parkway,
Bothell, Washington 98011 U.S.A.

Updates. To receive notification of future Software updates, please complete and return the registration
card. Also, please locate the serial number of your copy of the Software on the program media. You will
need this number to receive updates and technical support from Traveling Software.

Trademarks. TRAVELING SOFTWARE, LAPLINK and the associated logo(s) are registered trademarks of
Traveling Software, Inc. No right or license to any trademarks owned by Traveling Software or others
appearing in the Software or packaging is granted to you by this License Agreement.

Miscellaneous. Unless otherwise restricted by law, you agree that this License Agreement shall be con-
strued, interpreted and governed by the laws of the State of Washington of the United States of America,
without regard to the laws governing conflicts of law. If any action is brought by either party against the
other regarding any subject matter of this License Agreement, the prevailing party shall be entitled to
recover, in addition to any other relief granted, reasonable attorney fees and expenses of litigation. You
further agree that any claim relating to this License Agreement shall be brought in the courts of compe-
tent jurisdiction in the State of Washington. If any term of this License Agreement is declared void or
unenforceable by any court of competent jurisdiction, enforcement of the remaining terms shall not be
affected. No waiver of any right under this License Agreement shall be effective unless in writing and
signed by both parties. No waiver of any past or present right arising from any breach or failure to per-
form shall be deemed to be a waiver of any future right arising under this License Agreement. This Li-
cense Agreement sets forth the entire agreement between Traveling Software and you with respect to
all matters covered herein.

IF YOU HAVE ANY QUESTIONS CONCERNING THIS LICENSE AGREEMENT, PLEASE CONTACT TRAVEL-
ING SOFTWARE AT 18702 NORTH CREEK PARKWAY, BOTHELL, WASHINGTON 98011 U.S.A.
(425.483.8088), OR CONTACT YOUR REGIONAL TRAVELING SOFTWARE OFFICE.



	Contents
	1: Introducing LapLink Professional
	What is LapLink Professional?
	What you can do in LapLink Professional
	Getting help

	2: Connecting to Other Computers
	Connecting to other computers—Overview
	Connecting by modem—Overview
	Making a LapLink-to-LapLink connection by modem
	Connecting to a network by modem: Dial-Up Networking
	Using Address Book for modem connections

	Connecting over the Internet
	Determining an Internet address
	Using the Traveling Software WINS server for Internet connections
	Internet security and firewalls

	Connecting by network
	Connecting to computers outside of your TCP/IP subnetwork
	Using Address Book for network connections

	Connecting by cable
	Connecting by wireless
	Connecting over CAPI 2.0/ISDN
	Changing CAPI performance in LapLink Professional

	Changing the security setup
	Securing your computer and encrypting the data you transfer

	Connecting automatically

	3: Using Remote Control and Text Chat
	Using Remote Control—Overview
	Viewing the host
	Customizing keyboard control
	Disabling the host keyboard and mouse and blanking its screen
	Rebooting and logging on to the host
	Hosting a Remote Control session
	Sharing clipboard information with remote computers
	Customizing Remote Control performance
	Using Text Chat

	4: Using File Transfer
	Using File Transfer—Overview
	Navigating through drives and folders
	Selecting files and folders
	Copying or moving files and folders
	Setting File Transfer options for the results you want
	Synchronizing folders with SmartXchange
	Replacing one folder with another: Clone Folder
	Speeding file transfers with SpeedSync and compression
	Resuming an interrupted file transfer
	Transferring files with long names to Windows 3.1

	5: Automating File Synchronization with Xchange Agent
	Introduction to Xchange Agent
	Creating an Xchange Agent
	Previewing and running an Xchange Agent
	Dealing with conflicts

	Customizing an Xchange Agent
	Using filters to include or exclude files
	Scheduling an Xchange Agent to run automatically


	6: Using Print Redirection
	Using Print Redirection—Overview
	Printing over a LapLink connection
	Setting up printers for Print Redirection

	7: Troubleshooting Tips
	Introduction to troubleshooting
	Checklist for modem connections
	Checklist for Dial-Up Networking connections
	Checklist for network connections
	Checklist for cable connections
	Checklist for wireless connections
	Checklist for CAPI 2.0/ISDN
	Checklist for File Transfer
	Checklist for Xchange Agent
	Checklist for Remote Control
	Checklist for Print Redirection
	Checklist for Text Chat

	Index

